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Regulatory Compliance

Thermo Fisher Scientific performs complete testing and evaluation of its products to ensure full compliance with 
applicable domestic and international regulations. For more information, refer to manual for your Thermo Scientific 
mass spectrometer.

Changes that you make to your system might void compliance with one or more of these EMC and safety standards. 
Changes to your system include replacing a part or adding components, options, or peripherals not specifically 
authorized and qualified by Thermo Fisher Scientific. To ensure continued compliance with EMC and safety standards, 
replacement parts and additional components, options, and peripherals must be ordered from Thermo Fisher Scientific 
or one of its authorized representatives.

FCC Compliance Statement

Notice on the Proper Use of
Thermo Scientific Instruments

In compliance with international regulations: Use of this instrument in a manner not specified by Thermo Fisher 
Scientific could impair any protection provided by the instrument.

Notice on the Susceptibility 
to Electromagnetic Transmissions

Your instrument is designed to work in a controlled electromagnetic environment. Do not use radio frequency 
transmitters, such as mobile phones, in close proximity to the instrument.

For manufacturing location, see the label on the instrument.

THIS DEVICE COMPLIES WITH PART 15 OF THE FCC RULES. OPERATION IS SUBJECT TO 
THE FOLLOWING TWO CONDITIONS: (1) THIS DEVICE MAY NOT CAUSE HARMFUL 
INTERFERENCE, AND (2) THIS DEVICE MUST ACCEPT ANY INTERFERENCE RECEIVED, 
INCLUDING INTERFERENCE THAT MAY CAUSE UNDESIRED OPERATION.

CAUTION Read and understand the various precautionary notes, signs, and symbols contained inside 
this manual pertaining to the safe use and operation of this product before using the device.





WEEE Compliance

This product is required to comply with the European Union’s Waste Electrical & Electronic Equipment (WEEE) 
Directive 2002/96/EC. It is marked with the following symbol:

Thermo Fisher Scientific has contracted with one or more recycling or disposal companies in each European Union 
(EU) Member State, and these companies should dispose of or recycle this product. See www.thermo.com/
WEEERoHS for further information on Thermo Fisher Scientific’s compliance with these Directives and the 
recyclers in your country.

WEEE Konformität

Dieses Produkt muss die EU Waste Electrical & Electronic Equipment (WEEE) Richtlinie 2002/96/EC erfüllen.  
Das Produkt ist durch folgendes Symbol gekennzeichnet:

Thermo Fisher Scientific hat Vereinbarungen mit Verwertungs-/Entsorgungsfirmen in allen EU-Mitgliedsstaaten 
getroffen, damit dieses Produkt durch diese Firmen wiederverwertet oder entsorgt werden kann. Mehr Information 
über die Einhaltung dieser Anweisungen durch Thermo Fisher Scientific, über die Verwerter, und weitere Hinweise, 
die nützlich sind, um die Produkte zu identifizieren, die unter diese RoHS Anweisung fallen, finden sie unter  
www.thermo.com/WEEERoHS. 

http://www.thermo.com/WEEERoHS
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Conformité DEEE

Ce produit doit être conforme à la directive européenne (2002/96/EC) des  Déchets d'Equipements Electriques et 
Electroniques (DEEE). Il est marqué par le symbole suivant:

Thermo Fisher Scientific s'est associé avec une ou plusieurs compagnies de recyclage dans chaque état membre de 
l’union européenne et ce produit devrait être collecté ou recyclé par celles-ci. Davantage d'informations sur la 
conformité de Thermo Fisher Scientific à ces directives, les recycleurs dans votre pays et les informations sur les 
produits Thermo Fisher Scientific qui peuvent aider la détection des substances sujettes à la directive RoHS sont 
disponibles sur www.thermo.com/WEEERoHS. 

http://www.thermo.com/WEEERoHS
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Shock da folgorazione. L’apparecchio è 
alimentato da corrente ad alta tensione 
che puo provocare lesioni fisiche. Prima di 
effettuare qualsiasi intervento di 
manutenzione occorre spegnere ed isolare 
l’apparecchio dalla linea elettrica. Non 
attivare lo strumento senza lo schermo 
superiore. Non togliere i coperchi a 
protezione dalle schede di circuito 
stampato (PCB).

e contener 
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Prodotti chimici. Possibile presenza di 
sostanze chimiche pericolose 
nell’apparecchio. Indossare dei guanti per 
maneggiare prodotti chimici tossici, 
cancerogeni, mutageni, o 
corrosivi/irritanti. Utilizzare contenitori 
aprovo e seguire la procedura indicata per 
lo smaltimento dei residui di olio.

 que lop 
de efectuar 

Calore. Attendere che i componenti 
riscaldati si raffreddino prima di 
effetturare l’intervento di manutenzione.

ar el 
 

Incendio. Adottare le dovute precauzioni 
quando si usa il sistema in presenza di gas 
infiammabili.

icaduras de 
s que 
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.

Pericolo per la vista. Gli schizzi di 
prodotti chimici o delle particelle presenti 
nell’aria potrebbero causare danni alla 
vista. Indossare occhiali protettivi quando 
si maneggiano prodotti chimici o si 
effettuano interventi di manutenzione 
sull’apparecchio.

e existe un 
gorias 
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l usuario a 
n este 

Pericolo generico. Pericolo non 
compreso tra le precedenti categorie. 
Questo simbolo è utilizzato inoltre 
sull’apparecchio per segnalare all’utente 
di consultare le istruzioni descritte nel 
presente manuale.
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Quando e in dubbio la misura di sicurezza 
per una procedura, prima di continuare, si 
prega di mettersi in contatto con il 
Servizio di Assistenza Tecnica locale per i 
prodotti di Thermo Fisher Scientific San 
Jose.
CAUTION Symbol CAUTION VORSICHT ATTENTION PRECAUCION

Electric Shock: This instrument uses 
high voltages that can cause personal 
injury. Before servicing, shut down the 
instrument and disconnect the instrument 
from line power. Keep the top cover on 
while operating the instrument. Do not 
remove protective covers from PCBs.

Elektroschock: In diesem Gerät werden 
Hochspannungen verwendet, die 
Verletzungen verursachen können. Vor 
Wartungsarbeiten muß das Gerät 
abgeschaltet und vom Netz getrennt 
werden. Betreiben Sie Wartungsarbeiten 
nicht mit abgenommenem Deckel. Nehmen 
Sie die Schutzabdeckung von Leiterplatten 
nicht ab.

Choc électrique: L’instrument utilise des 
tensions capables d’infliger des blessures 
corporelles. L’instrument doit être arrêté et 
débranché de la source de courant avant 
tout intervention. Ne pas utiliser 
l’instrument sans son couvercle. Ne pas 
enlever les étuis protecteurs des cartes de 
circuits imprimés.

Descarga eléctrica: Este ins
utiliza altas tensiones, capace
producir lesiones personales. A
dar servicio de mantenimiento
instrumento, éste debera apag
desconectarse de la línea de a
eléctrica. No opere el instrume
cubiertas exteriores quitadas. N
las cubiertas protectoras de la
de circuito impreso.

Chemical: This instrument might contain 
hazardous chemicals. Wear gloves when 
handling toxic, carcinogenic, mutagenic, 
or corrosive or irritant chemicals. Use 
approved containers and proper 
procedures to dispose waste oil.

Chemikalien: Dieses Gerät kann 
gefährliche Chemikalien enthalten. Tragen 
Sie Schutzhandschuhe beim Umgang mit 
toxischen, karzinogenen, mutagenen oder 
ätzenden/reizenden Chemikalien. 
Entsorgen Sie verbrauchtes Öl 
entsprechend den Vorschriften in den 
vorgeschriebenen Behältern.

Chimique: Des produits chimiques 
dangereux peuvent se trouver dans 
l’instrument. Portez des gants pour 
manipuler tous produits chimiques 
toxiques, cancérigènes, mutagènes, ou 
corrosifs/irritants. Utiliser des récipients 
et des procédures homologuées pour se 
débarrasser des déchets d’huile.

Química: El instrumento pued
productos quimicos peligrosos
guantes al manejar productos 
tóxicos, carcinogenos, mutage
corrosivos/irritantes. Utilice re
procedimientos aprobados par
deshacerse del aceite usado.

Heat: Before servicing the instrument, 
allow any heated components to cool.

Hitze: Warten Sie erhitzte Komponenten 
erst nachdem diese sich abgekühlt haben.

Haute Temperature: Permettre aux 
composants chauffés de refroidir avant 
tout intervention.

Altas temperaturas: Permita
componentes se enfríen, ante 
servicio de mantenimiento.

Fire: Use care when operating the system 
in the presence of flammable gases.

Feuer: Beachten Sie die einschlägigen 
VorsichtsmaBnahmen, wenn Sie das 
System in Gegenwart von entzündbaren 
Gasen betreiben.

Incendie: Agir avec précaution lors de 
l’utilisation du système en présence de 
gaz inflammables.

Fuego: Tenga cuidado al oper
sistema en presencia de gases
inflamables.

Eye Hazard: Eye damage could occur 
from splattered chemicals or flying 
particles. Wear safety glasses when 
handling chemicals or servicing the 
instrument.

Verletzungsgefahr der Augen: 
Verspritzte Chemikalien oder kleine 
Partikel können Augenverletzungen 
verursachen. Tragen Sie beim Umgang mit 
Chemikalien oder bei der Wartung des 
Gerätes eine Schutzbrille.

Danger pour les yeux: Des projections 
chimiques, liquides, ou solides peuvent 
être dangereuses pour les yeux. Porter des 
lunettes de protection lors de toute 
manipulation de produit chimique ou pour 
toute intervention sur l’instrument.

Peligro par los ojos: Las sal
productos químicos o particula
salten bruscamente pueden ca
lesiones en los ojos. Utilice an
protectores al mnipular produc
químicos o al darle servicio de
mantenimiento al instrumento

General Hazard: A hazard is present that 
is not included in the above categories. 
Also, this symbol appears on the 
instrument to refer the user to instructions 
in this manual.

Allgemeine Gefahr: Es besteht eine 
weitere Gefahr, die nicht in den 
vorstehenden Kategorien beschrieben ist. 
Dieses Symbol wird im Handbuch 
auBerdem dazu verwendet, um den 
Benutzer auf Anweisungen hinzuweisen.

Danger général: Indique la présence 
d’un risque n’appartenant pas aux 
catégories citées plus haut. Ce symbole 
figure également sur l’instrument pour 
renvoyer l’utilisateur aux instructions du 
présent manuel.

Peligro general: Significa qu
peligro no incluido en las cate
anteriores. Este simbolo tambi
en el instrumento par referir a
las instrucciones contenidas e
manual.

When the safety of a procedure is 
questionable, contact your local Technical 
Support organization for Thermo Fisher 
Scientific San Jose Products.

Wenn Sie sich über die Sicherheit eines 
Verfahrens im unklaren sind, setzen Sie 
sich, bevor Sie fortfahren, mit Ihrer 
lokalen technischen 
Unterstützungsorganisation für Thermo 
Fisher Scientific San Jose Produkte in 
Verbindung.

Si la sûreté d’une procédure est 
incertaine, avant de continuer, contacter 
le plus proche Service Clientèle pour les 
produits de Thermo Fisher Scientific San 
Jose.

Cuando la certidumbre acerca 
procedimiento sea dudosa, an
proseguir, pongase en contact
Oficina de Asistencia Tecnica 
los productos de Thermo Fishe
San Jose.



CAUTION Symbol CAUTION

Electric Shock: This instrument uses 
high voltages that can cause personal 
injury. Before servicing, shut down the 
instrument and disconnect the instrument 
from line power. Keep the top cover on 
while operating the instrument. Do not 
remove protective covers from PCBs.

Chemical: This instrument might contain 
hazardous chemicals. Wear gloves when 
handling toxic, carcinogenic, mutagenic, 
or corrosive or irritant chemicals. Use 
approved containers and proper 
procedures to dispose waste oil.

Heat: Before servicing the instrument, 
allow any heated components to cool.

Fire: Use care when operating the system 
in the presence of flammable gases.

Eye Hazard: Eye damage could occur 
from splattered chemicals or flying 
particles. Wear safety glasses when 
handling chemicals or servicing the 
instrument.

General Hazard: A hazard is present that 
is not included in the above categories. 
Also, this symbol appears on the 
instrument to refer the user to instructions 
in this manual.

When the safety of a procedure is 
questionable, contact your local Technical 
Support organization for Thermo Fisher 
Scientific San Jose Products.
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Preface

This manual provides you with information on how to install, operate, and troubleshoot the 
Thermo Scientific NSI source.

The NSI source can be used on a TSQ™ Series, LCQ™ Series, or LTQ™ Series mass 
spectrometer.

Related Documentation
In addition to this guide, Thermo Fisher Scientific provides the following documents for the 
NSI source:

• Dynamic Nanospray Probe (NSI-1) Installation Guide

• Dynamic Nanospray Probe (NSI-2) Quick Reference Guide

The software also provides Help.

Safety and Special Notices
Make sure you follow the precautionary statements presented in this guide. The safety and 
other special notices appear in boxes.

Safety and special notices include the following:

Note  Thermo Fisher Scientific has discontinued the NSI-2 dynamic nanospray and 
packed-tip probes. For information about installing the NSI-1 dynamic nanospray probe, 
refer to the Dynamic Nanospray Probe (NSI-1) Installation Guide.

CAUTION  Highlights hazards to humans, property, or the environment. Each CAUTION 
notice is accompanied by an appropriate CAUTION symbol. 

CAUTION  Highlights electric shock hazards to humans. Each electric shock notice is 
accompanied by the international high voltage symbol.
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Preface
Safety and Special Notices
CAUTION  Highlights hot surface hazards to humans. Each hot surface notice is 
accompanied by the international hot surface symbol.

CAUTION  Highlights the necessity to wear protective eyewear. Each protective eyewear 
notice is accompanied by the international protective eyewear symbol.

CAUTION  Highlights sharp object hazards to humans. Each sharp object notice is 
accompanied by a sharp object symbol.

CAUTION  Highlights chemical hazards to humans, property, or the environment. Each 
chemical notice is accompanied by the chemical caution symbol.

IMPORTANT  Highlights information necessary to prevent damage to software, loss of 
data, or invalid test results; or might contain information that is critical for optimal 
performance of the system.

Note  Highlights information of general interest.

Tip  Highlights helpful information that can make a task easier.
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Preface
Contacting Us
Contacting Us
There are several ways to contact Thermo Fisher Scientific for the information you need. 

To contact Technical Support

Find software updates and utilities to download at mssupport.thermo.com.

To contact Customer Service for ordering information

To copy manuals from the Internet

Go to mssupport.thermo.com and click Customer Manuals in the left margin of the 
window. 

To suggest changes to documentation or to Help

• Fill out a reader survey online at http://www.surveymonkey.com/s/PQM6P62.

• Send an e-mail message to the Technical Publications Editor at 
techpubs-lcms@thermofisher.com.

Phone 800-532-4752

Fax 561-688-8736

E-mail us.techsupport.analyze@thermofisher.com

Knowledge base www.thermokb.com

Phone 800-532-4752

Fax 561-688-8731

E-mail us.customer-support.analyze@thermofisher.com

Web site www.thermo.com/ms
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Introduction

The nanospray ionization (NSI) source is a universal ion source that can be used on a 
TSQ™ Series mass spectrometer, an LCQ™ Series mass spectrometer, or an LTQ™ Series 
mass spectrometer.

The Thermo Scientific NSI source generates gas phase ions from sample solutions for analysis 
by a mass spectrometer. The effectiveness of the ionization process depends upon the 
concentration and ionization efficiency of the analyte. The Thermo Scientific NSI source is 
an improvement over conventional electrospray ion sources because nanospray ionization 
allows you to minimize the flow rate, which increases the signal response for dilute samples by 
increasing the effective analyte concentration at the emitter tip.

The NSI system gives you considerable flexibility in choosing the type of experiment required 
for a specific analysis. Nanospray operation can be performed in either of two modes: static 
nanospray or dynamic nanospray. Thermo Scientific offers two types of NSI probe for the 
dynamic nanospray mode: the dynamic NSI probe, which is used with a capillary column, 
and the packed-tip NSI probe, which is used with a PicoFrit™ column. 

Advantages of Nanospray
Electrospray ionization (ESI) has evolved as a leading technique for generating intact, gas 
phase ions from thermally labile, polar analytes in solution. In this technique, ionization is 
induced by the use of an emitter (a capillary tube or needle) at a controlled distance from a 
counter electrode. Dc voltage is applied, either to the needle or to the solvent, to produce a 
strong electrical field at the emitter tip. The electric field interacts with ions in solution as they 
leave the tip. This interaction results in electrohydrodynamic disintegration of the fluid, 
generation of droplets, and formation of an aerosol jet. See Figure 1. 

Contents

• Advantages of Nanospray

• Components of the Nanospray System
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Components of the Nanospray System
Figure 1. Electrohydrodynamic disintegration of the fluid

Conventional ESI employs flow rates from 1 μL/min to 1 mL/min. Due to the high volume 
of liquid exiting the emitter, a drying gas, thermal heating, or both are often required to 
expedite desolvation and droplet shrinkage. Nanospray ionization, which is a form of ESI that 
employs low flow rates from 10 to 1000 nL/min, generally does not require a drying gas or 
thermal heating. In addition, nanospray ionization is more tolerant to a wider range of liquid 
compositions including pure water.

As the flow rate is lowered, a lower volume of mobile phase passes through the emitter, 
producing smaller aerosol droplets. This makes nanospray ionization more effective than 
conventional ESI at concentrating the analyte at the emitter tip, producing significant 
increases in sensitivity demonstrated by the signal response of the mass spectrometer.

Components of the Nanospray System
The Nanospray system that mounts to your mass spectrometer consists of these components:

• NSI Source

• Extension Assembly

• Imaging System

Jet Droplets

PlumeTaylor coneNanospray tip
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Components of the Nanospray System
NSI Source

The NSI source assembly consists of the NSI flange, NSI base, and NSI probe. The NSI 
flange and NSI base are shown in Figure 2. 

Figure 2. NSI base mount and NSI flange

The flange contains the XYZ stage, which is used to make fine adjustments to the position of 
the NSI probe. The NSI base mounts to the NSI flange and holds the NSI probe. A dynamic 
NSI source is shown in Figure 3.

Figure 3. NSI source with (discontinued) dynamic NSI probe and column supports

NSI flange

Alignment slot

Y-axis 
adjustment 
knob

Critical screw 
length pin

X-axis 
adjustment 
knob

NSI base 
mount

Phillips head 
attachment screw
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Components of the Nanospray System
Thermo Scientific offers three types of NSI probes: 

• Static NSI Probe

• Dynamic NSI Probe

• Packed-Tip NSI Probe

Static NSI Probe

The static NSI probe, shown in Figure 4, can perform a continuous analysis of small sample 
(analyte) solution volumes over an extended period of time. The static nanospray mode is 
particularly useful for obtaining detailed structural information using MS/MS for purified 
samples or those present in a simple mixture. For instructions on assembling the static NSI 
probe, refer to “Assembling the Static NSI Probe” on page 44.

Figure 4. Static nanospray probe

Dynamic NSI Probe

The dynamic NSI probe, shown in Figure 5, uses a capillary column and a solvent delivery 
system to perform chromatographic separations on mixtures prior to analysis by the mass 
spectrometer. For instructions on assembling the dynamic NSI probe, refer to “Assembling 
the Dynamic NSI Probe” on page 49.

Note  Thermo Fisher Scientific has discontinued the NSI II dynamic nanospray probe. 
For information about ordering and installing the original dynamic nanospray probe, refer 
to the Dynamic Nanospray Probe I Installation and Operation Guide.
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Components of the Nanospray System
Figure 5. Dynamic nanospray probe (discontinued version)

Packed-Tip NSI Probe

The packed-tip NSI probe shown in Figure 6 uses PicoFrit® columns, which are emitters 
packed with HPLC column material. The PicoFrit column is an integral separation and spray 
device, which circumvents the junction issues encountered when using a capillary column and 
a fused silica emitter. For instructions on installing a PicoFrit column, refer to “Replacing the 
PicoFrit Column” on page 55. 

Figure 6. Packed-tip dynamic nanospray probe

Adapter for capillary column for 
zero dead volume union

Conductive front nut with 
orientation arrow
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Components of the Nanospray System
Extension Assembly

In most cases, the NSI source does not mount directly to the mass spectrometer, but instead 
mounts to an extension assembly. The extension assembly is mounted directly to the inlet of 
the mass spectrometer.

Depending on the geometry of the mass spectrometer’s inlet, the extension assembly includes 
either a 2-in. deep adapter ring or an Ion MAX adapter. In addition, a 1 in. deep adapter ring 
is required for the proper spacing of the dynamic NSI probe and might be required for the 
proper spacing of the packed-tip NSI probe. 

Mass spectrometers that support the NSI source can be categorized into two groups based on 
their inlet geometries:

• LCQ Deca XP and LCQ Advantage XP mass spectrometers have a protruding inlet with 
a circular base. The adapter system for these mass spectrometers is shown in Figure 7.

Figure 7. LCQ Deca XP or LCQ Advantage XP mass spectrometer adapter system

• Mass spectrometers with an Ion MAX ion source have a protruding inlet with a square 
base. This category of mass spectrometers includes the LCQ Deca XP MAX, the 
LTQ Series, and the TSQ Series. The adapter system for these mass spectrometers is 
shown in Figure 8.

NSI base 
mount

NSI
flange

2 in. deep 
adaptor ring

Mass 
spectrometer 
inlet

1 in. deep adaptor ring 
(for dynamic nanospray)
6 Nanospray Ion Source User Guide Thermo Scientific



 1 Introduction
Components of the Nanospray System
Figure 8. LCQ Deca XP MAX, LTQ Series, or TSQ Series mass spectrometer adapter system

See Chapter 3 for information on installing the appropriate extension assembly for your mass 
spectrometer.

Imaging System

The imaging system facilitates the positioning of the emitter and allows you to troubleshoot 
emitter problems. The imaging system mounts to the nanospray adapter for your mass 
spectrometer. See Figure 9. For instructions on installing the imaging system, refer to 
Chapter 4.

Figure 9. Imaging system mounted to mass spectrometer
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Ion Max 
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Camera stand

Camera body
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2

Working with Microfluidic Components and 
Microflow LC

The Thermo Scientific NSI source connects to a solvent delivery system and an injection 
valve (the Divert/Inject valve on the front of the mass spectrometer or the injection valve of an 
autosampler or manual injector) through narrow bore tubing. Plumbing of narrow bore 
tubing with micron sized inner diameters, low dead volume connections, and fused silica 
capillary tubing is referred to in this manual as microfluidics. Assembling the plumbing for a 
Thermo Scientific NSI source is no more difficult than assembling traditional HPLC 
plumbing, but it is helpful to keep several key factors in mind when working with 
microfluidics. These factors are discussed in this chapter.

Performing chromatography with a microflow LC requires a capillary column or a PicoFrit 
column and a capillary pump or a conventional LC pump used in combination with a flow 
splitter. Instructions for working with PicoFrit columns, connecting a flow splitter, and 
determining the column flow rate are included in this chapter, along with suggestions for 
maintaining a stable nanospray.

Contents

• Preparing the Microfluidic Worksite

• Working with Microscale Fittings and Tubing

• Cutting Tubing and Emitter Tips

• Selecting an Emitter

• Working with PicoFrit Columns

• Controlling the Column Flow Rate

• Configuring the System for Microscale LC/MS Experiments

• Effect of Solvents on Maintaining a Stable Nanospray
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2 Working with Microfluidic Components and Microflow LC
Preparing the Microfluidic Worksite
Preparing the Microfluidic Worksite
Proper preparation of the worksite for the handling of microfluidic components is critical to 
the successful operation of your NSI/MS system. Inadequate worksite preparation and a lack 
of cleanliness can result in clogged tubing or compromised emitters, causing experimental 
failure. The extra effort required to maintain a clean and dedicated workbench for the 
preparation and handling of microfluidics quickly translates to reduced maintenance and 
superior nanospray performance.

Use a stereoscope or microscope to check the microfluidic components of your system prior to 
assembling them. A robust, high-quality lab stereoscope, with magnification between 10× to 
30×, is an essential part of the microfluidics worksite. An example of such a stereoscope is the 
Leica™ Zoom 2000 (Model No. Z30V, VWR Cat. No. 41433-030 / Leica No13312594F).

Ensure that the air in your laboratory does not contain excessive dust, smoke, or other 
particulate matter. Dust can contaminate or clog columns and emitters and can also form an 
insulating layer on the electronics of your mass spectrometer. When columns or emitters 
become blocked, overheating and short-circuiting of the electronic components of your mass 
spectrometer, as well as sample loss can occur. For reference, the air should contain fewer than 
100 000 particles of size exceeding 5 μm per cubic foot. 

Working with Microscale Fittings and Tubing
The nanospray ion source components are assembled with various types of plastic couplings. 
MicroTight™ fittings and tubing couplings use fine-pitch threads that are more prone to cross 
threading than are the coarser threads of conventional HPLC fittings. Alignment is 
important, so ensure that the coupling axis coincides with the tubing axis. For the same 
tightening torque, fine threads exert more clamping force than coarse threads, enough to 
distort ferrules and partially collapse tubing. As a basic rule, initially tighten a coupling 
connection finger tight. Then, tighten it no more than an additional 1/4 turn.

Capillary tubing (fused silica tubing) is assembled with a tubing sleeve, a nut, and a ferrule, as 
shown in Figure 10. The capillary tubing is inserted into the coupling sleeve, and then the 
coupling nut and the ferrule are slid onto the sleeve. The ends of the tubing, sleeve, and 
ferrule must be flush as they are inserted into the bottom of the coupling, and then held in 
place while the nut is threaded into the coupling finger tight.

Note  See “Cutting Tubing” on page 13 for recommendations regarding techniques for 
cutting tubing. Ensure that the ends are cut squarely and that the edges of the cut are 
smooth.
10 Nanospray Ion Source User Guide Thermo Scientific



 2 Working with Microfluidic Components and Microflow LC
Working with Microscale Fittings and Tubing
Figure 10. Coupling of capillary tubing

Disconnecting and then reconnecting coupling unions involving fused silica tubing and 
tubing sleeves is not recommended. Once you disconnect a coupling joint, you compromise 
the sleeve and ferrule component for further use. Discard or replace used fittings; do not reuse 
them.

Prior to making connections, clean the coupling components by flushing them with a high 
quality solution made from LC-MS grade solvents. It is sometimes helpful to assemble the 
microfluidic components as you flush the system with water. Begin the assembly of the 
microfluidic components with the fittings connected to the LC pump. Using this procedure, 
micro particulates are flushed out before they enter the narrow bore section of the system. In 
addition, flushing with water as you make the microfluidic connections can help you identify 
potential problems before you start an experiment.

For optimum performance, use LC-MS grade methanol, acetonitrile, water, and isopropyl 
alcohol when operating and maintaining the NSI source and your mass spectrometer. Store 
and handle solvents in accordance with recognized standard laboratory safety procedures. To 
reduce potential clogging problems caused by particulates, centrifuge samples prior to their 
injection into the microfluidic system.

Assembling the microfluidic components of an NSI source involves the use of tubing of 
various diameters. Be careful not to mix tubing of differing inner diameters because this can 
lead to bubble formation and flow disturbances. Maintaining consistent tubing ID reduces 
excess dead volume and unnecessary pressure differentials.

IMPORTANT      Do not filter solvents. Use LC-MS grade solvents instead of filtered 
solvents. Using filtered solvents in the MS detector can introduce contamination into the 
system.

Note  

• Some solvent impurities are transparent to certain detectors. For example, 
spectroscopic grade solvents that are suitable for UV detectors might contain 
contaminants that interfere with the performance of the MS detector. For operation 
of your MS detector, use only LC-MS grade solvents.

• Thermo Fisher recommends that only LC-MS grade solvents from the following 
manufacturers be used: Merck, Mallinckrodt, or Burdick & Jackson.

Sleeve Nut Ferrule Coupling

Tubing
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2 Working with Microfluidic Components and Microflow LC
Cutting Tubing and Emitter Tips
Excess tubing length, the major contributor to dead volume, can significantly increase 
experimental run times. Table 1 correlates tubing diameter with volume, allowing you to 
calculate the total dead volume for a given system.

Use Table 1 to estimate the excess experimental run time caused by excess tubing. Determine 
the internal volume for your tubing from the table. To calculate the additional run time due 
to this tubing, divide its volume by your column flow rate. For example, if you use 10 cm of 
76 μm ID tubing to connect your injection valve to your capillary column and you set your 
column flow rate (using a flow splitter) to 0.1 μL/min, it takes approximately 4.6 minutes for 
the injected sample to reach the column inlet. Each additional centimeter of tubing adds an 
additional 0.46 minutes to your run time.

Cutting Tubing and Emitter Tips
In microfluidics, you work with a variety of tubing and emitter types. These topics describe 
how to cut tubing and emitter tips:

• Cutting Tubing

• Cutting Emitters

Table 1. Correlation between tubing IDs and volume

Tubing ID
inches

Tubing ID
micrometers

Volume
μL/inch

Volume
μL/cm

0.001 25 0.013 0.005

0.002 51 0.051 0.020

0.003 76 0.116 0.046

0.005 127 0.322 0.127

0.006 152 0.463 0.182

0.010 254 1.287 0.507

0.015 381 2.896 1.140

0.018 457 4.170 1.642

0.028 711 10.90 3.973

CAUTION  Wear ANSI approved safety glasses and non-powdered gloves when handling 
fused silica tubing and emitters.
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 2 Working with Microfluidic Components and Microflow LC
Cutting Tubing and Emitter Tips
Cutting Tubing

The technique used to cut tubing is critical for the tubing to exhibit proper flow 
characteristics. The following procedure describes the recommended technique for cutting 
tubing.

To cut tubing

1. Place the tubing adjacent to a ruler. Then, mark the necessary length with a felt tip pen.

You can prevent the formation of particulates and contamination of the tubing end 
during the cutting procedure by working on a clean, hard-surfaced table. A quick wipe of 
the table with alcohol or another volatile solvent will eliminate most microparticles.

2. Holding the diamond-edged scribe blade (P/N 00725-00082) at right angles to the 
tubing axis and to the work surface, apply a light, gentle pressure to the tubing surface to 
create a nick.

A freestanding 4× magnifier can be useful for orienting the scribe properly on the tubing. 
Light scoring is sufficient to create a nick in the surface of the polyimide coating.

Figure 11 shows an emitter tip being cut.

Figure 11. An emitter tip being cut to specified length

3. Keeping your fingers away from the ends, take the tubing in both hands, flex it briefly 
about 20° away from the nick (see Figure 12a), and then bend it briskly toward the nick 
to snap it (see Figure 12b).

Note  Do not use lateral motion to score the tubing surface. Be careful not to force 
the blade through the tubing.

Nick (exaggerated)
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2 Working with Microfluidic Components and Microflow LC
Cutting Tubing and Emitter Tips
Figure 12. Snapping the tubing for a square end

4. Examine the snapped-off end at a magnification of 10× to 30× to ensure that the cut is 
square and smooth. If the cut is not square or smooth discard the piece of tubing or cut its 
end again.

A flat, smooth cut is essential to the integrity of a low dead volume connection. Small leaks 
can result from improperly cut tubing. Such leaks are usually invisible and are only detected 
by inconsistent system performance, for example, unreliable spray. 

Plastic tubing used in the experimental setup is cut with a conventional guillotine-type cutter 
or a sharp razor blade. Thin-walled tubing tends to collapse in guillotine-type cutters and 
special care has to be taken to avoid the deformation of the tubing end. 

Certain types of tubing require variations of the described basic technique. For example, 
PicoTips™ of heavy glass or quartz need a somewhat deeper nick, which can be accomplished 
by a slight rocking of the scribe in a plane at right angles to the tip. If overdone, however, this 
rocking motion can produce unwanted fine particles.

Cutting Emitters 

Cut the emitter to a suitable length before assembling the NSI probe. For the packed-tip 
NSI probe, the appropriate emitter length is 10.5 cm. For the static NSI probe, the 
appropriate emitter length (for offline PicoTips) is 2.7 cm. Order pre-cut emitters for the 
dynamic NSI probe from New Objective, Inc. The distal end of these emitters is polished, 
guaranteeing better performance.

A cleanly cut, square end is essential to the stable performance of the emitter. If the end of 
the emitter is not cut squarely, it will not seat properly in the associated fittings and couplings. 
If not cut cleanly, the ragged end might introduce particles capable of clogging the tip of the 
emitter. To avoid extra column effects associated with poorly seated fittings and clogging 
caused by particulate contamination, inspect the cut end of the emitter at a magnification of 
10× to 30× with a robust, high-quality lab stereoscope. 

Tip  Thermo Fisher Scientific recommends that you practice several cuts on a piece of 
straight fused silica tubing prior to cutting costly emitters. 

IMPORTANT      Clogged emitter tips can also lead to long run times and inconsistent 
system performance.

(a)

(b)
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Selecting an Emitter
If you detect particulate contamination, you can clean the emitter with water or other solvents 
before you assemble the dynamic NSI probe. However, washing offline PicoTips, which are 
used for static nanospray, is not recommended because the same capillary action that allows 
you to load samples into the tip of the emitter will also draw the wash solvent into the 
capillary. This trapped solvent will act as a diluent when you load samples.

Selecting an Emitter
Nanospray emitters are divided into two groups depending on their use: static (offline) 
emitters and dynamic (online) emitters. A range of emitter tip IDs is available for both 
groups. The following topics describe the variables that affect your choice of emitter ID:

• Static Nanospray Emitters

• Dynamic Nanospray Emitters

Static Nanospray Emitters

Static nanospray permits continuous analysis of small sample (analyte) solution volumes 
over an extended period of time. This method is particularly useful for obtaining detailed 
structural information using MS/MS for purified samples or those present in a simple 
mixture. A small aliquot of sample solution, usually less than 1 μL in volume, is loaded into a 
metal-coated pulled glass capillary with a tip internal diameter (ID) ranging from 1 to 4 μm. 
Voltage is applied to the metal coating on the tip. Simultaneously, an air-filled syringe 
provides a constant backpressure to initiate and maintain electrospray. After electrospray has 
commenced, the electric field and solvent properties provide a self-regulated flow rate.

To adjust the flow rate, you modify the parameters that affect the strength of the electric field. 
These parameters include the emitter tip ID, the spray voltage applied to the emitter or liquid 
junction, and the distance between the emitter and ion transfer tube (the counter electrode). 
If you change the parameters that affect the electric field strength, you change the flow rate 
and therefore alter the stability of the nanospray. Adjusting the spray voltage and optimizing 
the emitter position are described in the Tuning chapter of this manual that applies to your 
mass spectrometer.

PicoTip™ emitters supplied by New Objective Inc. are used with the static NSI probe. Refer 
to Table 2 to select the appropriate emitter ID for your application. The supplier provided 
flow rate ranges are based on the generation of a stable electrospray plume. Because the 
generation of a stable electrospray plume also depends on the applied voltage, the solvent 
composition, and the ion source, your results might differ.

IMPORTANT      Be careful not to touch the open ends of emitter tips with any surface 
while handling them.
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Dynamic Nanospray Emitters

For dynamic nanospray, the appropriate emitter tip ID depends on the flow rate. The optimal 
flow rate for an application is typically determined by the capillary column that is required to 
provide an adequate separation. The dynamic NSI probe uses capillary columns with IDs 
ranging from 100 to 500 μm and supporting flow rates of 0.1 to 3 μL/min. 

Refer to Table 3 to select the appropriate emitter ID for your application. The supplier 
provided flow rate ranges are based on the generation of a stable electrospray plume. Because 
the generation of a stable electrospray plume also depends on the applied voltage, the solvent 
composition, and the ion source, your results might differ.

The packed-tip NSI probe uses a PicoFrit column, which is an integrated column, frit, and 
spray tip. The optimal flow rate range for the 75 μm ID PicoFrit column is 200 to 
300 nL/min. In addition to a capillary column, the dynamic NSI probe uses a pre-cut, 5 cm 
SilicaTip™ emitter with a polished distal end. You can order these emitters from New 
Objective, Inc.

Table 2. Effective flow rate range for PicoTip emitters

Emitter ID (μm) Flow rate (nL/min)

1 20 to 80

2 20 to 80

4 40 to 100

Table 3.  Effective flow rate range SilicaTip emitters 

Emitter ID (μm) Flow rate (nL/min)

5 20 to 100

8 100 to 300

10 100 to 400

15 150 to 400

30 300 to 1000
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Working with PicoFrit Columns
The packed-tip dynamic NSI probe is shipped with a PicoFrit column, which allows the 
ionization of molecules directly from the column outlet. The proximity of the column outlet 
to the MS interface minimizes post column losses and increases sensitivity.

PicoFrit columns are fabricated from 360 μm OD, polyimide-coated, fused-silica tubing. One 
end of the column, referred to here as the tip end, has a specially tapered tip with an integral 
high-porosity frit. Behind the frit is the packed chromatography bed. There is no frit at the 
back end of the bed, only unpacked fused-silica tubing. Mobile phase flow must always be 
directed toward the tip. Reversing the flow can result in partial or complete unpacking of the 
chromatography bed.

Figure 13 shows a schematic of a PicoFrit column.

Figure 13. PicoFrit column (schematic)

PicoFrit columns are shipped in lengths of 50 cm fused-silica tubing. The ends of the column 
are protected by a piece of clear FEP tubing forming a loop. The PicoFrit column is stored in 
solvent, which keeps the distal end and the tapered tip end of the column at the same pressure 
during storage and shipping, and prevents the column from drying out.

For a mass spectrometer and NSI source, the PicoFrit columns need to be cut to 10.5 cm. 

To cut a PicoFrit column and connect it to a packed-tip NSI probe

1. Carefully remove the PicoFrit column from its shipping box. 

2. Locate the arrow on the PicoFrit label that points toward the tip end to identify the distal 
end of the column (opposite side of the arrow pointer). See Figure 14. 

Note  For proper handling and use of PicoFrit columns, refer to their package inserts.

IMPORTANT      Do not remove the column ends from the loop until the PicoFrit column 
is ready for installation and conditioning.

Packed bed

Fused-silica tubing 
50 cm length 

75 μm ID × 360 μm OD

Polyimide 
coating

Bare fused-silica 
tubing

TipFrit
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Figure 14. PicoFrit column as shipped

3. Remove the distal end of the column from the loop by pulling it free from the sleeve or by 
cleaving the fused silica tubing near the distal end. Leave the tapered tip end of the 
column in the FEP sleeve until the column is ready for mounting on the packed-tip NSI 
probe.

4. Connect the distal end of the column to the nano LC (LC pump with flow splitter) and 
condition the column with 50:50 organic / aqueous solvent for several minutes. This 
repacks the column bed, which might have become loose during shipping and handling.

5. Place a mark 10.5 cm from the tip end of the column on the polyimide coating, and then 
cleave the PicoFrit column as described in “Cutting Tubing and Emitter Tips” on 
page 12.

6. Remove the tip end of the PicoFrit column from the FEP sleeve by sliding the PEEK 
sleeve with the label towards the tip end until it butts up against the FEP sleeve (see 
Figure 3 in the package insert).

7. Point the tip vertically towards the ground and carefully push the PEEK sleeve against the 
FEP sleeve until the FEP sleeve falls off. It might take a lot of force to move the FEP 
sleeve 3 to 5 mm.

PF
C7

51
5A

Q
1 

Pi
co

Fr
it 

Co
lu

m
n 

® 

Distal end

FEP sleeve

PEEK sleeve 
with label

Fused-silica 
column

Frit end

CAUTION  Wear ANSI approved safety glasses and non-powdered gloves when 
handling and cutting glass tubing.
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8. Attach the PicoFrit column to the packed-tip NSI probe as described in “Replacing the 
PicoFrit Column” on page 55.

9. Mount the packed-tip probe into the base mount of the NSI source.

10. Ensure that your mass spectrometer is in the Standby mode, and then reconnect the NSI 
source to the mass spectrometer as described in “Connecting the NSI Source to the 
Extension Assembly” on page 61.

Controlling the Column Flow Rate
To perform high-sensitivity analyses of mixtures, install either the dynamic NSI probe or the 
packed-tip NSI probe onto your mass spectrometer. The dynamic NSI probe uses either a 
capillary or nano LC column. The packed-tip NSI probe uses a PicoFrit column.

Conventional HPLC systems with analytical packed columns of internal diameters between 3 
to 4.6 mm employ flow rates from a hundred microliters per minute to several milliliters per 
minute. Most commercially available chromatography equipment, including the LC pump, 
has been designed to operate at those flow rates. Capillary and nano-LC performs best at a 
flow rate of about 1 to 10 μL/min and below, which is 100 to 1000 times lower than 
conventional LC flow rates. Table 4 compares flow rates and column ID of various HPLC 
techniques to illustrate the difference in flow rate requirements.

Some LC pumps can form reproducible solvent gradients at flow rates as low as 50 to 
200 μL/min, but few LC pumps can produce flow rates under solvent gradient conditions in 
the low μL/min range. To couple a standard LC pump to your dynamic NSI/MS system, you 
must split the solvent flow delivered by the LC pump into two solvent streams with one 
stream flowing through the capillary LC column as the other stream is diverted to waste.

Note  Do not let the PEEK sleeve slide off the end of the tip, but instead remove it by 
sliding it off the distal end of the column. 

Table 4. Comparison of flow rates and column internal diameters for various HPLC techniques 
(adapted from Chervet et al, Anal.Chem., 68, pp. 1507–1512 (1996)).

HPLC Technique Flow Rate Column ID

Conventional 0.5 to 2 mL/min 3.2 to 4.6 mm

Microbore 0.1 to 0.5 mL/min 1.5 to 3.2 mm

Micro 10 to 100 μL/min 0.5 to 1.5 mm

Capillary 1 to 10 μL/min 150 to 500 μm

Nano 10 to 1000 nL/min 10 to 150 μm
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These topics describe how to control the column flow rate:

• Splitting Flow from an LC Pump

• Adjusting the Column Flow Rate

• Measuring the Column Flow Rate

Splitting Flow from an LC Pump

You split the flow from an LC pump with a simple Tee union. The tubing and fitting 
components of the flow splitter are illustrated in Figure 15.

Figure 15. Flow splitting components

As illustrated in Figure 15, a flow splitter divides the solvent flow delivered by an LC pump 
into two flow streams. The bleed-off or restriction line carries the majority of flow to waste. 
The rest of the flow passes through the LC-tee union towards the column. The restriction line 
is a piece of narrow-bore fused-silica tubing (for example, 50 μm ID with 360 μm OD, 
P/N 00106-10512) that is cut to a specific length to provide a defined leak for excess solvent 
bleed-off to waste. The flow rate of the solvent shunted to the LC column section of the flow 
spitting assembly is referred to as the column flow rate.

To 
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Adjusting the Column Flow Rate

The column flow rate is adjusted by increasing or decreasing the length of the restriction line. 
To decrease the column flow rate, you decrease the length of the restriction line. To increase 
the column flow rate, you increase the length of the restriction line.

The effect of adjusting the length of the restriction line on the column flow rate is shown in 
Figure 16 and Figure 17. For a 150 mm × 180 μm ID column, reducing the length of the 
restriction line from 50 to 30 cm reduces the column flow rate from 2.8 to 1.7 μL/min. For a 
150 mm × 320 μm ID column, reducing the length of the restriction line from 25 to 10 cm 
reduces the column flow rate from to 5.3 to 2.8 μL/min.

Figure 16. Effect of restriction line length on the flow rate for a 150 mm × 180 μm ID column

4.0

3.5

3.0

2.5

2.0

1.5

1.0

0.5

0.0

30 cm length restriction line
(split flow ratio 1:110)

 

Co
lu

m
n 

flo
w

 ra
te

 (μ
L/

m
in

)

LC pump flow rate (μL/min)

50 cm length restriction line
(split flow ratio 1:70) 

0 50 100 150 200 250 300

Effect of the restriction line length on the column flow rate
(150 mm × 180 μm ID column)
Thermo Scientific Nanospray Ion Source User Guide 21



2 Working with Microfluidic Components and Microflow LC
Controlling the Column Flow Rate
Figure 17. Effect of restriction line length on the flow rate for a 150 mm × 320 μm ID column

The values listed in Table 5 were experimentally determined for the columns supplied by 
Thermo Scientific. Other microscale columns might require different operating conditions.

To reduce the column flow rate to a suitable level 

1. See Table 5 to determine the optimum flow rate for the ID of your LC column. For 
example, Table 5 recommends the following:

• A flow rate range of 0.9 to 1.5 μL/min for a 150 mm × 180 μm ID column

• A flow rate range of 3.0 to 5.0 μL/min for a 150 mm × 320 μm ID column

2. Set your LC pump to the lowest stable flow rate for your application. To maintain a stable 
flow rate, most LC pumps require a higher setting for gradient pump programs than for 
isocratic pump programs. Setting the LC pump to deliver mobile phase at its lowest 
possible stable flow rate will allow you to maintain a lower split flow ratio.

Table 5. Operating guidelines for capillary columns

HPLC Parameter Packed Column (1) Packed Column (2) PicoFrit Column (3)

Column ID 320 μm 180 μm 75 μm

Flow Rate 3 to 5 μL/min 0.9 to 1.5 μL/min 200 to 300 nL/min

Max Sample Mass 570 ng 180 ng 50 ng

Max Peak Volume 550 nL 175 nL 30 nL

Note  It is often useful to start working with larger ID capillary columns before turning to 
more demanding nanoscale experiments.

10 cm Restriction Line
(split flow ratio 1:70)

C
o

lu
m

n
 f

lo
w

 r
a

te
 (

μL
/m

in
)

LC pump flow rate (μL/min)

25 cm Restriction Line
(split flow ratio 1:40)  

0 50 100 150 200 250 300

Effect of Restriction Line Length on Column Flow Rate
(150 mm x 320 μm ID column)

7.0

6.0

5.0

4.0

3.0

2.0

1.0

0.0
22 Nanospray Ion Source User Guide Thermo Scientific



 2 Working with Microfluidic Components and Microflow LC
Controlling the Column Flow Rate
3. Determine the length of restriction tubing that will allow you to set a stable LC pump 
flow rate and that will produce the column flow rate determined in step 1. To determine 
the appropriate length of restriction tubing for the 150 mm × 180 μm ID and the 
150 mm × 320 μm ID columns that are provided in the NanoFlow solution kit, see 
Figure 16 or Figure 17, respectively.

For example, you can determine from Figure 16 that the split flow ratios for the 50 cm 
and the 30 cm restriction lines are approximately 1:70 and 1:110, respectively, for the 
150 mm × 180 μm ID column. To achieve a column flow rate of 1 μL/min, the flow rate 
for the LC pump must be set to 70 μL/min for the 50 cm restriction line or to 
110 μL/min for the 30 cm restriction line. If your LC pump can maintain a stable flow at 
both of these flow rates, select the restriction line length that yields the lowest split flow 
ratio.

4. Cut a fused silica line (P/N 00106-10512) to the length determined in step 3 and 
assemble the flow splitter as described in “Splitting Flow from an LC Pump” on page 20.

5. Set the LC pump flow rate. Then, measure the actual column flow rate as described in the 
next topic, “Measuring the Column Flow Rate” on page 23.

6. Make fine adjustments to the LC pump flow rate to reach the optimum column flow rate. 
Several iterations of LC pump flow rate changes might be necessary to reach the desired 
column flow rate.

You can construct a graph similar to the ones in Figure 16 and Figure 17 for quick adjustment 
of the column flow rate.

Measuring the Column Flow Rate

To make a direct measurement of the column flow rate, you need a disposable micropipette 
(1 to 5 μL, Fisher Scientific, Cat No 21-164-2A) or a similar piece of volumetric glassware 
and a stopwatch.

To determine the column flow rate

1. Butt the micropipette directly to the outlet of the HPLC column. Then, allow the 
micropipette to fill to the graduated mark. 

2. Note the length of time required to fill the micropipette. 

Tip  Low split ratios are preferable. Splitting down from 8 μL/min to 50 nL/min (1:160) is 
preferable to splitting down from 500 μL/min to 500 nL/min (1:1000). If large split ratios 
are used, adjustment of the LC pump flow rate is less effective for fine-tuning the column 
flow rate. 

IMPORTANT      When using packed-tip columns, the outlet of the column is the emitter, 
so take special care when using the following procedure to avoid damaging or clogging the 
tip.
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3. Divide the volume collected in the micropipette by the measured time to obtain the flow 
rate through the HPLC column.

Configuring the System for Microscale LC/MS Experiments
Successful experimentation with microscale LC/MS requires the adaptation of all system 
hardware components as well as their operating parameters to the microscale range. To obtain 
the best chromatographic performance with a microscale LC/MS system, the injected sample 
volume, sample concentration, or both have to correspond with the requirements of the 
separation column, as shown in Table 5.

For small amounts of sample or if diluted solutions need to be concentrated onto the 
microscale column, place the injection valve between the flow splitter and the column. See 
Figure 18. This configuration allows all of the injected sample plug to reach the LC column 
and is preferred for systems capable of injecting low micro to nanoliter sample volumes.

Figure 18. Injection valve between the flow splitter and the LC column

Tip  You can also determine the column flow rate indirectly by performing a loop injection 
experiment. For information on determining the column flow rate by performing a loop 
injection experiment, contact your local Thermo Fisher Scientific service engineer.
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Effect of Solvents on Maintaining a Stable Nanospray
The optimum spray voltage and flow rate for an experiment are affected by the properties of 
the solvents used. Solvents with higher surface tension require greater electrical fields to start 
the nanospray. Table 6 displays the surface tension of three typical solvents used in LC/MS. 
If you are running a gradient pump program, you need to consider the fact that the surface 
tension of the liquid exiting the emitter near the beginning of the gradient, where the solvent 
is mostly aqueous, differs from that near the end of the gradient, where the solvent is mostly 
organic.

Since solvent needs to be differentially removed from the analyte by evaporation, use only 
volatile additives in the solvent matrix. As with ESI, avoid non-volatile salts and buffers. They 
can clog the emitter. If salts are required in the solvent matrix, it is better to use ammonium 
rather than sodium or potassium salts.

Table 6. Surface tension of common solvents used in LC/MS

Solvent Surface Tension (N/m)

Acetonitrile 0.0226

Methanol 0.030

Water 0.073
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Installing the Nanospray Extension Assembly

This chapter describes how to install the interface components required to provide the 
appropriate distance between the emitter tip of the NSI probe and the inlet of the mass 
spectrometer. These components include the Ion MAX adapter, the 2-inch deep adapter ring 
for dynamic nanospray, and the 1-inch deep adapter ring.

The nanospray extension assembly is the mounting surface for the imaging system and the 
NSI source. 

To prepare your mass spectrometer for the installation of the imaging system and the 
NSI source, follow these procedures:

1. Preparing for Nanospray Installation

2. Installing the Components of the Extension Assembly

Preparing for Nanospray Installation
These topics describe how to prepare the mass spectrometer for installation of the Thermo 
Scientific nanospray ion source:

• Nanospray Power Requirements

• Removing the API Source

Nanospray Power Requirements

The Thermo Scientific NSI source (including its associated components) operates within the 
range of 100 V to 240 V ac, at 50 to 60 Hz, and requires a power outlet in addition to that 
needed for the mass spectrometer. Therefore, you need two power outlets to operate both the 
NSI source and the mass spectrometer. 

Contents

• Preparing for Nanospray Installation

• Installing the Components of the Extension Assembly
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Removing the API Source

Before you can install the new NSI source, you must remove the current API source from your 
mass spectrometer. 

To remove the API source, do one of the following

• If your mass spectrometer is already configured with a previous version of the nanospray 
ion source, put your system in the Standby mode. Then, follow the instructions provided 
in the manual that was shipped with your original NSI source to remove it. Do not 
remove the 2-inch Nanospray Adapter Ring or the imaging system. 

The original NSI source includes an NSI flange, NSI body, and NSI probe. You can use 
the NSI flange that shipped with the original version of the nanospray system after you 
remove its ZDV arm. You cannot use the NSI body with the new NSI probes.

• If your mass spectrometer is configured with an ESI or APCI ion source, remove the ion 
source by following the instructions provided in the Hardware manual for your mass 
spectrometer.

• If your mass spectrometer is configured with a Ion MAX™ ion source, follow the 
instructions provided in the Ion Max API Source Hardware Manual to remove it.

Installing the Components of the Extension Assembly
The extension assembly, which mounts directly to the mass spectrometer, positions the 
NSI probe at an appropriate distance from the inlet of the mass spectrometer. The 
components of the extension assembly depend on the geometry of the mass spectrometer inlet 
and the type of NSI probe used. To determine the components of the extension assembly for 
your mass spectrometer and NSI probe, see Table 7.

This section contains the following procedures:

• Installing the Ion MAX Adapter

• Installing the Two-Inch Deep Adapter Ring

• Installing the One-Inch Deep Adapter Ring for Dynamic Nanospray

IMPORTANT      Place your LC/MS system in the Standby mode before you remove the 
API source.
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To install the appropriate extension assembly for your mass spectrometer, do one of the 
following:

• If you have a mass spectrometer with an Ion MAX ion source, go to “Installing the Ion 
MAX Adapter,”  below.

• If your mass spectrometer has a protruding inlet with a circular base, go to “Installing the 
Two-Inch Deep Adapter Ring” on page 31. This category includes the LCQ Advantage, 
LCQ Deca XP, and LCQ Deca XP Plus mass spectrometers.

• If you have already installed the 2-inch Nanospray Adapter Ring for the previous version 
of the nanospray ion source and you are preparing to install the either the new dynamic 
NSI probe or the new packed-tip NSI probe, go to “Installing the One-Inch Deep 
Adapter Ring for Dynamic Nanospray” on page 32.

Installing the Ion MAX Adapter

To install the Ion MAX adapter on your mass spectrometer

1. If you have not already done so, remove the Ion MAX ion source as described in the Ion 
Max API Source Hardware Manual. 

2. Carefully align the two guide pin holes on the back of the Ion MAX adapter (see 
Figure 19) with the guide pins on the mass spectrometer (see Figure 20). 

Table 7. Components of extension assembly

Inlet Geometry Extension Assembly Components 
for the Static NSI Probe

Extension Assembly Components 
for the Dynamic NSI Probe and the 
Packed-Tip NSI Probe

Protruding inlet with a circular base 2-inch adapter ring 2-inch adapter ring

1-inch adapter ring

Protruding inlet with a square base Ion MAX adapter Ion MAX adapter

1-inch adapter ring
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Figure 19. Ion MAX adapter, showing ion source guide pin holes

Figure 20. Mass spectrometer, showing ion source guide pins

3. Ensure that the Ion MAX adapter locking levers are open (pointing away from the mass 
spectrometer), and gently push the Ion MAX adapter onto the mass spectrometer.

Ion source 
guide pin holes

Ion source 
guide pins
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4. Rotate the Ion MAX adapter locking levers 90 degrees to lock the nanospray extension 
assembly onto the mass spectrometer.

5. Depending on the type of NSI probe you are installing, do one of the following:

• If you are installing a dynamic NSI probe or a packed-tip NSI probe, go to “Installing 
the One-Inch Deep Adapter Ring for Dynamic Nanospray” on page 32. 

• If you are installing a static NSI probe, you have completed the installation of the 
extension assembly and are now ready to install the imaging system. Proceed to 
Chapter 4.

Installing the Two-Inch Deep Adapter Ring

Because the LCQ Advantage, LCQ Deca XP, and LCQ Deca XP Plus mass spectrometers 
have a protruding inlet with a circular base, they require a 2-inch deep adapter ring.

To install the 2-inch deep adapter ring

1. If you have not already done so, remove the conventional API source as described in the 
Hardware manual for your mass spectrometer.

2. With the viewing window on the nanospray adapter ring facing upwards, align its 
extension screws with the threaded holes (4 o’clock and 10 o’clock) on the API spray 
shield. 

3. Use a 3/16-in. Allen wrench to tighten the extension screws to the API spray shield. See 
Figure 21.

Figure 21. Tightening the extension screws on the 2-inch adapter ring
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4. Depending on the type of NSI probe you are installing, do one of the following:

• If you are installing a dynamic NSI probe or a packed-tip NSI probe, go to “Installing 
the One-Inch Deep Adapter Ring for Dynamic Nanospray” on page 32. 

• If you are installing a static NSI probe, you have completed the installation of the 
extension assembly and are now ready to install the imaging system. Proceed to 
Chapter 4.

Installing the One-Inch Deep Adapter Ring for Dynamic Nanospray

If you are installing a dynamic NSI probe or a packed-tip NSI probe, you need to install the 
1-inch deep adapter ring.

To install the 1-inch deep adapter ring

1. Do one of the following:

• For mass spectrometers with an Ion MAX adapter, go to step 2.

• For mass spectrometers with the two-inch adapter ring, go to step 3.

2. With the heads of the two socket head screws facing away from the mass spectrometer, 
slide the alignment slot in the bottom of the one-inch adapter ring over the alignment tab 
of the Ion MAX adapter. Then, tighten the socket head screws to the Ion MAX adapter 
with a 4 mm Allen wrench. See Figure 22.

Figure 22. LTQ Series mass spectrometer with the Ion MAX adapter and the one-inch adapter 
ring installed

You have completed the installation of the extension assembly for your NSI source. Go to 
Chapter 4.

Ion Max adapter

1-inch deep adapter ring

Socket head screws
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3. With the heads of the two socket head screws facing away from the mass spectrometer, 
align the socket head screws of the one-inch adapter ring with the mounting holes on the 
two-inch adapter ring. Then, use a 4 mm Allen wrench to tighten the socket head screws 
to the two-inch adapter ring.

You have completed the installation of the extension assembly for your new NSI source. 
If this is your first nanospray system, proceed to Chapter 4. If you have already installed 
the imaging system, proceed to Chapter 5.
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Installing the Imaging System

The Thermo Scientific NSI source comes equipped with an imaging system to facilitate 
positioning of the emitter and to troubleshoot emitter problems.

Imaging System Components
The major components of the imaging system are as follows:

• CCD camera

• Camera lens system

• Lens extension tube set

• Osprey video capture card and software

• Camera stand

• LED light source

Some of the components have been pre-assembled. The LED light source is positioned below 
the NSI source to backlight the nanospray droplets. The camera is attached to the video 
capture card to display the probe and the emitter tip on the computer workstation.

Before you can install the imaging system, you must install the adapter for the NSI source as 
described in Chapter 3. 

Contents

• Imaging System Components

• Imaging System Installation
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Imaging System Installation
To install the imaging system, follow these procedures:

1. Assembling the CCD Camera and Optics

2. Installing the Camera Assembly

3. Installing the Video Capture Card

4. Adjusting the Imaging System

Assembling the CCD Camera and Optics

The CCD camera and optics are shipped unassembled. Before you mount the camera to your 
mass spectrometer, you need to assemble it. 

To assemble the CCD camera and optics system

1. Carefully remove the CCD camera and optics from their shipping container and place the 
components on a clean surface.

2. Remove the lens cap from the camera.

3. Screw the lens extension tube set to the camera.

4. Attach the lens system to the extension tube by inserting the lens into the extension tube 
and tightening the three hex nuts. See Figure 23.

Figure 23. Imaging system camera assembly

The CCD camera and optics system is now assembled and is ready to be installed on the 
camera stand as described in the next section, “Installing the Camera Assembly.” .

Camera body Extension tube Lens

Hex nut(s)
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Installing the Camera Assembly 

The CCD camera and the LED light source are installed on the nanospray extension 
assembly. If the nanospray extension assembly is not already mounted on your mass 
spectrometer, refer to the installation instructions in Chapter 3 before proceeding with the 
following procedure.

To mount the camera and the LED light source on the nanospray extension assembly

1. Attach the camera stand to the nanospray extension assembly as follows:

• On a LCQ Advantage, LCQ Deca XP, or LCQ Deca XP Plus mass spectrometer, 
mount the camera stand on the top of the nanospray adapter ring as shown in 
Figure 24.

Figure 24. Camera stand mounted to the 2-inch deep adapter ring
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• On a mass spectrometer that was shipped with an Ion MAX ion source (with the 
exception of a TSQ Series mass spectrometer) mount the camera stand as shown in 
Figure 25.

Figure 25. Camera stand mounted to an Ion MAX adapter

• On a TSQ Series mass spectrometer, mount the camera stand on the left side of the 
Ion MAX adapter.

2. Install the LED by screwing the LED retainer clockwise into the bottom of the Ion MAX 
adapter or the nanospray adapter ring. See Figure 26 and Figure 27. 

Figure 26. 12 V dc Power supply and LED with cable

Bracket for 
LED cable

12 V dc power supply LED

Connects to the 12 V dc 
power supply

Connects to the power port 
on the top of the camera
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Imaging System Installation
Figure 27. Installation of the LED into the bottom of the Ion MAX adapter

3. Route the LED cable through the bracket in the camera stand. 

Installing the Video Capture Card

You need to install a video capture card into the PC so that the image can be processed by the 
computer and displayed on the monitor. This section contains a general procedure for 
installing the video capture card. Refer to Appendix B, “Installing the Osprey MultiMedia 
Capture Device, Software, and Drivers.”  for a more detailed installation procedure.

To install the Osprey™ MultiMedia Capture Card

1. Turn off and unplug the computer.

2. Remove the computer cover and insert the video capture card into a vacant PCI slot. See 
Figure 28.

IMPORTANT      Wear a grounding strap when installing the video capture card.
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Figure 28. Installation of the video capture card into the computer

3. Reinstall the computer cover.

4. Boot up the computer.

5. Cancel out of the Microsoft™Windows™ New Hardware Found wizard (use the Osprey 
MultiMedia Capture Driver installation CD instead).

6. Install the appropriate video capture card driver from the installation CD provided by 
Osprey.
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Adjusting the Imaging System

The imaging system needs to be adjusted before initial use of your nanospray ion source. 

To adjust the imaging system

1. Place the camera in the camera stand as illustrated in Figure 29.

Figure 29. Camera mounted in camera stand, showing the camera adjustment screws

2. Connect one end of the BNC cable to the Video port on the top of the camera. Connect 
the other end of the BNC cable to the video capture card.

3. Connect the LED cable to the Power port on the top of the camera.

4. Connect the LED cable to the 12 V dc power supply. See Figure 26 on page 38.

5. Ensure the proper operation of the video capture card by starting the multimedia software 
application on your computer. From the Start menu, choose Start > Programs > Osprey 
MultiMedia Capture > VidCap32 to display the VidCap window. See Figure 30.

BNC cable connection to 
video output of camera

Adjustment screws
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Figure 30. Illustration of the proper LED positioning

6. With the camera stand adjustment screws fully retracted, position the camera to achieve 
the best view of the ion transfer tube orifice.

7. Adjust the position of the LED light so that the back side of the inlet cone is illuminated 
(Figure 30).

8. Once you have achieved good camera positioning, tighten the adjustment screws on the 
camera stand.

The above steps are basic to focusing the camera. Practice is required to develop a sense of how 
camera movement affects the position of the image on the monitor.

The installation of the imaging system is complete. Go to Chapter 5 to continue the 
installation of your new NSI probe.

Note  During nanospray operation and for troubleshooting purposes, adjusting the focal 
length of the camera in a counterclockwise direction towards infinite focal length gives a 
clear and focused picture of the spray tip pointing towards the inlet tube.

Nanospray tip

Electrospray 
plume

Light is positioned directly beneath ion transfer tube to backlight 
nanospray droplets. Note corona effect on inlet.
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Assembling the NSI Probe

Thermo Scientific offers three types of interchangeable nanospray probes: the static NSI 
probe, the dynamic NSI probe, and the packed-tip NSI probe.

For instructions on assembling your new NSI probe, refer to one of the sections in this 
chapter.

Static NSI Probe
This section contains the following topics:

• Static NSI Probe Components

• Assembling the Static NSI Probe

Static NSI Probe Components

The static NSI probe contains an emitter that is pulled from a glass or quartz capillary to a tip 
of 1 to 2 μm ID and is coated with gold/palladium to enable electrical contact. The O-ring in 
the center of the nose cone tip assembly holds the body of the static nanospray emitter in 
place.

The components of the static NSI probe are shown in Figure 31.

Note  Thermo Fisher Scientific has discontinued the NSI-2 dynamic nanospray and 
packed-tip probes. For information about ordering and installing the original dynamic 
nanospray probe, refer to the Dynamic Nanospray Probe (NSI-1) Installation.

Contents

• Static NSI Probe

• Dynamic NSI Probe

• Packed-Tip NSI Probe

CAUTION  Take care to avoid touching the emitter tip. It is sharp enough to puncture the 
skin.
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Static NSI Probe
Figure 31. Static NSI probe components

Assembling the Static NSI Probe

To assemble the static NSI probe, follow these procedures:

1. Cutting the Static NSI Emitter

2. Inserting the Static Emitter into the Nose Cone Tip

3. Loading Sample into the Static Emitter

4. Connecting the Nose Cone Tip Mount Assembly to the Probe Body

Cutting the Static NSI Emitter

Using a high-quality diamond chip or sapphire cutting tool, cut the static NSI emitter to a 
length of about 27 mm. You need to make a square cut or the emitter will not seat properly in 
the associated fittings and couplings. You also need to make a clean cut because loose particles 
will quickly clog the tip of the emitter. Refer to “Cutting Tubing and Emitter Tips” on 
page 12 for recommendations.

Probe body Proximal coated 
PicoTip™ emitter

Nose cone mount

Nose cone tip

CAUTION   Avoid touching the emitter tip. It is sharp enough to puncture the skin.

IMPORTANT      It is very easy to damage or break the tip of the emitter. Avoid touching 
any hard surface with the emitter tip. 

Note  Purchase PicoTip™ emitters for static nanospray (also referred to as offline 
nanospray) from New Objective, Inc.
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Static NSI Probe
Inserting the Static Emitter into the Nose Cone Tip

To insert the static emitter into the nose cone tip

1. Before you handle the emitter, make sure that you are wearing safety glasses and 
non-powdered gloves.

2. With one hand holding the nose cone tip, use the other hand to guide the flat end of the 
emitter through the hole in the center of the nose cone. See Figure 32.

Figure 32. Guiding the flat end of the emitter through the hole in the center of the 
nose cone tip

3. If you cannot fit the flat end of the emitter through the tip of the nose cone, remove the 
emitter and use a flat head screwdriver to adjust the collar inside the nose cone tip as 
follows (see Figure 33 and Figure 34): 

• To tighten the emitter, adjust the collar clockwise to compress the O-ring. 

• To loosen the emitter, adjust the collar counterclockwise to decompress the O-ring.

Figure 33. Collar inside the nose cone tip assembly

CAUTION  Wear ANSI approved safety glasses and non-powdered gloves when 
handling emitters. 

Adjustment slot for 
screwdriver
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Static NSI Probe
Figure 34. Nose cone tip assembly (exploded view)

4. Using tweezers, gently push the emitter further into the nose cone tip until 5 to 8 mm of 
the emitter protrudes through the end of the tip. Ensure that the metal contact clip 
touches the coating on the emitter. 

Loading Sample into the Static Emitter

Use a micropipette equipped with a gel-loading tip to transfer 1 to 5 μL of bubble-free sample 
to the static nanospray emitter. Thermo Fisher Scientific recommends gel loading tips with a 
fine, 350 μm OD tip for this process (Eppendorf/Brinkman Catalog number 22 35 465-6). 

To tune the mass spectrometer with the NSI source, use a tuning solution that has a sample 
concentration of 1 to 5 pmol/μL. For instructions on preparing an appropriate tuning 
solution for your NSI/MS system, refer to the Getting Started Guide or Appendix C, “Tuning 
Solutions for the NSI Mode.” 

To load sample into the static emitter

1. Insert the pipette tip into the flat end of the static NSI emitter. Push the pipette tip into 
the emitter until you feel resistance.

2. To avoid forming air bubbles, slowly deliver 1 to 5 μL of liquid as you gradually remove 
the pipette tip from the emitter.

IMPORTANT      To avoid removing the coating from the emitter, do not slide the emitter 
in and out of the nose cone tip mount assembly.

PicoTip emitter

Collar

O-ring

Contact clip

IMPORTANT      High concentrations of the tuning solution can contaminate the system. 
Tuning solutions prepared for a conventional ESI source must be diluted 100-fold before 
being used with the NSI source.

Note  For best results, centrifuge samples before loading them into the emitter to remove 
any particulates from the supernatant.
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Although you cannot push the tip of a gel loading pipette into the tip of an emitter, 
capillary action will cause the sample to fill the tip of the emitter within a few minutes.

3. Gently shake the emitter to remove any air bubbles that might have formed.

Connecting the Nose Cone Tip Mount Assembly to the Probe Body

The nose cone tip mount assembly consists of the nose cone tip assembly and the nose cone 
mount assembly. The nose cone tip assembly contains the loaded emitter. The nose cone 
mount assembly consists of a nut, a locking ring, and an O-ring.

To connect the nose cone tip mount assembly to the probe body

1. Connect the nose cone tip assembly, which is holding the loaded emitter, to the nose cone 
mount assembly as follows:

a. Align the flat end of the emitter with the hole in the center of the nose cone 
mounting nut, and then insert the emitter into the hole. 

b. Screw the locking ring of the nose cone mount assembly onto the nose cone tip 
assembly until it is finger tight. 

2. Holding the locking ring, screw the nose cone tip mount assembly into the body of the 
probe until you feel resistance. See Figure 35 and Figure 36.

If you continue tightening the nose cone tip mounting assembly beyond the point of 
resistance, the nose cone tip will begin to detach from the nose cone mounting nut. If this 
happens, remove the nose cone tip mounting assembly from the probe and retighten the 
locking ring. Then, being careful not to overtighten the connection, reconnect the nose 
cone tip mounting assembly to the probe

Figure 35. Nose cone detached from the body of the static NSI probe

Nose Cone Tip Mount Assembly

Nut

Locking Ring

Nose Cone Tip
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Dynamic NSI Probe
Figure 36. Static NSI probe assembled

Dynamic NSI Probe
This section contains the following topics:

• Dynamic NSI Probe Components

• Assembling the Dynamic NSI Probe

Dynamic NSI Probe Components

The components of the (discontinued) dynamic NSI probe are shown in Figure 37.

Figure 37. Components of the dynamic NSI probe required to install emitter

Adapter nut

ZDV union 
(for infusion experiments)

8 cm × 50 μm ID 
PEEKsil tubing

MicroFerrule 
(Upchurch P/N F-132)

Dynamic probe 
body

Adapter 
sleeve

MicroFerrule, black 
(for 0.025 in. OD sleeve) 
(Upchurch P/N F-172)

Front nut, conductiveFerrule 
(Upchurch P/N F-142)

Female nut 
(Upchurch P/N P-416)

PicoTip emitter 5 cm, 
pre-cut and polished 

IMPORTANT      To avoid performance failures, use these recommended parts. Order 
pre-cut, 8 cm length, 50 μm ID, PEEKsil tubing (natural) from Upchurch Scientific. 
See Figure 38. Order pre-cut and polished, 5 cm length, PicoTip emitters from 
New Objective, Inc. The performance of the dynamic nanospray probe depends on the 
tolerances of these components.
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Dynamic NSI Probe
Figure 38. PEEKsil tubing with 50 μm ID

Assembling the Dynamic NSI Probe

To assemble the (discontinued) dynamic NSI probe

1. Connect a capillary column or a ZDV union to the PEEKsil tubing:

a. Slide the adapter nut and a ferrule onto the precut, 8 cm length of 50 μm ID 
PEEKsil tubing (Upchurch P/N 6508-1). See Figure 39.

Figure 39. PEEKsil tubing with adapter nut and ferrule

b. Depending on the type of experiment, do one of the following:

• For an LC/MS experiment, screw the adapter nut into one end of a capillary 
column. Hold the tubing against the bottom of the receiving port as you screw 
the adapter nut into the column end finger tight. Using a 5/16-in. open-end 
wrench and a 1/4-in. open-end wrench, tighten the fittings by an additional 1/4 
turn to swage the ferrule onto the PEEKsil tubing.

• For a tuning experiment, screw the adapter nut into one end of a ZDV union. 
Hold the tubing against the bottom of the receiving port as you screw the adapter 
nut into the union finger tight. Using two 5/16-in. open-end wrenches, tighten 
the fittings by an additional 1/4 turn to swage the ferrule onto the PEEKsil 
tubing. See Figure 40.

Natural
 (Beige)

50 μm ID 

Note  PEEKsil tubing is color coded. Use natural (beige), 50 μm ID PEEKsil 
tubing with the dynamic nanospray probe. See Figure 38.

Ferrule 
(Upchurch P/N F-142)

Adapter nut 
(Upchurch P/N S-2494-16)

8 cm PEEKsil tubing 
(50 μm ID, 1/16 in. OD)
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Figure 40. Connecting the ZDV union

2. Connect the PEEKsil tubing to the dynamic nanospray probe:

a. Insert the free end of the PEEKsil tubing through the hole in the back of the dynamic 
nanospray probe. See Figure 41.

Figure 41. Inserting the PEEKsil tubing through the back of the probe

b. Slide the MicroFerrule over the end of the PEEKsil tubing that is protruding from 
the front of the probe. See Figure 42.

Figure 42. Slipping the Microferrule onto the PEEKsil tubing

c. As you gently press the PEEKsil tubing against the receiving port in the back of the 
front nut, screw the front nut into the probe until finger tight. Then, confirm the 
tightness of the connection by gently pulling on the capillary column or the ZDV 
union. See Figure 43 and Figure 44.

IMPORTANT      The front nut is unidirectional. The arrow etched on the front 
nut points in the direction of the solvent flow. See Figure 43.

ZDV union
5/16 in. OD

Adapter nut 
5/16 in. OD

PEEKsil tubing
50 μL ID, natural

PEEKsil tubing protruding
from the front of the probe

MicroFerrule 
(Upchurch P/N F-132)
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Figure 43. Internal view of the front nut, showing the orientation of the front nut and the 
PEEKsil tubing connection

The directional arrow that is etched on the front nut must face away from the probe 
body. See Figure 44.

Figure 44. Screwing the front nut onto the front of the probe

Front Back

Direction of solvent flow

PEEKsil tubing, 
natural

MicroFerrule 
(Upchurch P/N F-132)

Receiving port in the 
back of the front nut

The directional arrow 
that is etched on the 
front nut must face away 
from the probe body

Front nut
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3. Connect a PicoTip emitter to the front of the probe as follows:

a. Taking care to avoid touching the emitter tip, thread the blunt end (distal end) of the 
PicoTip emitter through the adapter sleeve. Using a magnifier, ensure that the end of 
the sleeve is flush with the blunt end of the emitter. See Figure 45.

Figure 45. Sleeved PicoTip emitter

b. Holding the female nut with its interior threads facing away from the emitter tip, 
slide the nut over the blunt end of the sleeved emitter. See Figure 46.

Figure 46. Sliding the female nut over the sleeved emitter

c. To ensure proper seating, slide the blunt end of the sleeved emitter through the black 
MicroFerrule (Upchurch P/N F-172) until it protrudes slightly (approximately 
1 to 2 mm) from the front of the MicroFerrule. See Figure 47.

Figure 47. Sliding the Microferrule over the blunt end of the emitter

Blunt end of the 
emitter

Adapter sleeve 
(Upchurch P/N F-185)

Emitter tip

CAUTION  Do not touch the emitter tip. It is sharp enough to puncture skin.

IMPORTANT      Do not touch the emitter tip. Doing so will damage it.

Female nut 
(Upchurch P/N P-416)

Blunt end of the 
emitter

Emitter tip

Emitter tip

MicroFerrule, black 
(Upchurch P/N F-172)

Blunt end of the emitter 
(enlarged)
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d. Gently pressing the sleeved emitter against the bottom of the receiving port in the 
front side of the front nut, screw the female nut onto the front nut until finger tight. 
Be careful not to overtighten the fitting. 

e. Unscrew the female nut and verify the following:

• The black MicroFerrule is swaged onto the sleeved emitter.

• The end of the sleeved emitter protrudes from the tip of the black MicroFerrule.

• The blunt end of the emitter is flush with the sleeve.

Figure 48. Front nut, showing the PEEKsil and the emitter connections

f. Reconnect the emitter to the probe. Pressing the sleeved emitter against the receiving 
port in the front of the front nut, screw the female nut onto the front nut. 

Figure 49 shows the dynamic nanospray probe assembled for a tuning experiment.

Figure 49. Dynamic nanospray probe, assembled for a tuning experiment

IMPORTANT      It is extremely important that the PEEKsil tubing and the sleeved 
emitter are seated properly in the receiving ports of the front nut. See Figure 48.

If these components are not seated properly, you will see band broadening in your 
chromatograms and a loss in sensitivity.

MicroFerrule, black 
(Upchurch P/N F-172)

Receiving port in the front 
of the front nut

Emitter 
tip

Ferrule Nut
Front NutMicroFerrule

(Upchurch
P/N F-132)

ZDV union
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Packed-Tip NSI Probe
This section describes the components of the packed-tip NSI probe and how to replace the 
PicoFrit column. Occasionally, the PEEKsil tubing portion of the liquid junction becomes 
clogged. For instructions on replacing the PEEKsil tubing, refer to “Replacing the PEEKsil 
Tubing of the Packed-Tip NSI Probe” on page 115.

This section contains the following topics:

• Packed-Tip NSI Probe Components

• Replacing the PicoFrit Column

Packed-Tip NSI Probe Components

The components of the packed-tip NSI probe are shown in Figure 50 and Figure 51.

Figure 50. Components of the packed-tip NSI probe

Probe cover

Liquid junction

PicoFrit column

Probe 
body

Spring retainer
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Figure 51. Liquid junction of the packed-tip NSI probe

Replacing the PicoFrit Column

To replace the PicoFrit column of the packed-tip NSI probe

1. Put your LC/NSI/MS system in the Standby mode and ensure that the solvent flow from 
the LC pump is Off.

2. Loosen, and then remove the short head nut on the back of the probe to disconnect the 
plumbing between the packed-tip NSI probe and the LC system or the syringe pump. 

3. Detach the NSI source from the mass spectrometer.

4. Detach the packed-tip probe from the NSI source.

5. Pull the probe cover off the probe body. See Figure 50 on page 54.

6. Pull the liquid junction out of the spring retainer.

7. Unscrew the fingertight fitting that connects the PicoFrit column to the liquid junction. 
Then, dispose of the used PicoFrit column. See Figure 52.

Short 
head nut

Ground 
junction Tube 

nuts

PEEKsil 
tubing Voltage 

junction
Standard nut 
(blue)

PicoFrit 
column

Ferrule

Conductive 
union 
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Figure 52. Liquid junction of packed-tip NSI probe

8. Using the fingertight fitting, connect a new emitter to the voltage junction of the liquid 
junction.

9. Reinsert the liquid junction into the spring retainer.

10. Reattach the probe cover to the probe body.

Figure 53 shows the assembled packed-tip NSI probe.

Figure 53. Packed-tip NSI probe assembled

Short 
head nut

Ground 
junction

Tube 
nuts

Fingertight 
fitting

Emitter

Ferrule

Voltage 
junction
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6

Installing the NSI Source

The NSI source includes the NSI flange, the NSI base mount, and the NSI probe. 
Thermo Fisher Scientific offers three types of interchangeable NSI probes: the static 
NSI probe, the dynamic NSI probe, and the packed-tip NSI probe. For instructions on 
assembling your NSI probe, refer to Chapter 5.

To install your new NSI source, follow the procedures that apply to your nanospray system:

1. Assembling the NSI Source

2. Connecting the NSI Source to the Extension Assembly

3. Aligning the Emitter Tip Position

4. Completing the Plumbing Connections

CAUTION  Do not modify the protective glass shield or any other part of the NSI source. 
By making modifications, you could potentially expose yourself to dangerously high 
voltages!

Contents

• Assembling the NSI Source

• Connecting the NSI Source to the Extension Assembly

• Aligning the Emitter Tip Position

• Completing the Plumbing Connections
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Assembling the NSI Source
The NSI source includes an NSI flange, an NSI base mount, and an NSI probe.

To assemble your NSI Source, follow these procedures:

1. Attaching the NSI Base Mount to the NSI Flange

2. Inserting the NSI Probe into the NSI Base Mount and NSI Flange Assembly

Attaching the NSI Base Mount to the NSI Flange

When you initially install your NSI source, you need to attach the NSI base mount to the 
NSI flange. 

To attach the NSI base mount to the NSI flange

1. Slide the alignment slot in the NSI base mount over the critical screw length pin on the 
NSI flange. See Figure 54.

Figure 54. Critical screw length pin and alignment slot in the NSI base mount

2. Using a #1 Phillips head screwdriver, tighten the screw that secures the NSI base mount 
to the NSI flange.

Note  If you are using the previous version of the NSI flange, use a Phillips head 
screwdriver to remove its ZDV union.

CRITICAL  SC
REW  LENGTH

 

NSI flange

NSI base mount

Protective glass 
shield

Critical screw
length pin

Alignment slot
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Figure 55. View of Phillips head screw

Inserting the NSI Probe into the NSI Base Mount and NSI Flange Assembly

To install the NSI probe into the NSI base mount

1. Slide the NSI probe into the NSI base mount until it snaps into place.

2. For capillary columns that need additional support, connect the column support 
assembly to the NSI base mount:

a. Assemble the column support assembly if you have not already done so by slipping 
the rods through the holes in the column guide. Do not connect the column clamp 
to the column guide.

You connect the column clamp to the column guide after you align the capillary 
column with the notch in the center of the column guide.

b. Loosen the two column support retaining screws on the NSI base mount. See 
Figure 56.

Phillips 
head screw

Note  The column support assembly is shipped in pieces. The assembly consists of 
two rods, a column guide, a column clamp, and two retaining screws. An additional 
column guide and column clamp are provided.
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Figure 56. Holes for column support assembly in the NSI base mount

c. Insert the rods of the column support assembly into the holes in the NSI base mount 
as far as they will go. Then, tighten the retaining screws.

d. Ensure that the capillary column is supported by the notch in the center of the sliding 
column guide. Then, connect the column clamp to the column guide.

3. Connect the high voltage cable of the NSI probe to the high voltage port on the NSI base 
mount by inserting the pin at the end of the high voltage cable into the high voltage port 
on the NSI base mount. Then, slip the high voltage shield that surrounds the pin over the 
port. 

Figure 57 shows the dynamic NSI probe, Figure 58 shows the packed-tip NSI probe, 
and Figure 59 shows the static NSI probe.

Figure 57. NSI source with dynamic NSI probe

Column support assembly

Retaining 
screwColumn 

clamp

Column 
guide

Retaining 
screw

Holes for the column 
support assembly

Dynamic NSI probe

High-voltage cable
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Figure 58. NSI source with packed-tip NSI probe

Figure 59. NSI source with static NSI probe

Connecting the NSI Source to the Extension Assembly
To connect the NSI source to the extension assembly

1. If the NSI source contains either a dynamic NSI probe or a packed-tip NSI probe, install 
the 1-in. deep adapter ring if it is not already installed as follows: 

a. Align the alignment slot on the 1 in. deep adapter ring with the alignment tab on the 
NSI extension assembly (see Figure 60). Then, slide the 1-in. deep adapter ring onto 
the extension assembly.

Packed-tip NSI probe

High-voltage cable

Static NSI probe

High-voltage cable
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Connecting the NSI Source to the Extension Assembly
Figure 60. Extension assembly mounted on the mass spectrometer (front view)

b. Secure the 1 in. deep adapter ring to the extension assembly by tightening the socket 
head screws. See Figure 61.

Figure 61. LTQ mass spectrometer shown with extension assembly and 1 in. deep 
adapter ring

2. Ensure that the XYZ stage of the NSI source is fully retracted. If necessary, turn the 
Z position adjustment knob (see Figure 62) counterclockwise to retract the stage.

Extension 
assembly 
alignment tab

Socket head screws

1-in. adapter ring for the 
dynamic probe
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Connecting the NSI Source to the Extension Assembly
Figure 62. NSI source with dynamic NSI probe

3. Align the NSI source alignment slot with the alignment tab on the NSI extension 
assembly. Then, slide the NSI source onto the extension assembly.

4. Tighten the two flange retainer bolts to secure the NSI source to the NSI extension 
assembly.

5. Connect the high voltage cable from the Ion MAX adapter to the high voltage cable 
connector on the NSI base mount. Turn the locking ring on the cable clockwise to secure 
the connection. See Figure 63.

Flange retainer bolts

Y-position 
adjustment knob

X-position 
adjustment knob

Z-position
adjustment knob

Alignment 
slot

High voltage cable 
receptacle

High voltage 
connection to the 
NSI probe

CAUTION  AVOID ELECTRICAL SHOCK. Make certain that all electrical voltages are at 
ground potential before handling the high voltage cable.
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6 Installing the NSI Source
Aligning the Emitter Tip Position
Figure 63. High voltage connection between Ion MAX adapter and the NSI base mount

Aligning the Emitter Tip Position 
After you install the probe, align the position of the emitter tip with the center of the ion 
transfer tube.

To align the position of the emitter tip

1. Use the X and Y adjustment knobs on the XYZ stage to align the emitter tip with the 
center of the ion transfer tube. See Figure 62 on page 63.

Spray quality can be affected if the emitter is more than 1 mm (within 1 mm tolerance) 
from the center of the ion transfer tube.

2. Use the Z adjustment knob to position the emitter approximately 2 mm away from the 
ion transfer tube. See Figure 62 on page 63 and Figure 64.

Figure 64. View through the window of the Ion MAX adapter, showing the Z-axis distance 
between the emitter and the ion transfer tube

High Voltage Cable 
Connection
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Completing the Plumbing Connections
Completing the Plumbing Connections
Refer to the following sections of this manual for instructions on connecting the NSI probe to 
syringe pump on the front of your mass spectrometer or to your LC system:

• If you are preparing to tune your NSI/MS system or operate the static NSI probe, refer to 
Chapter 7.

• If you are preparing to perform an LC/NSI/MS experiment, refer to “Configuring the 
System for Microscale LC/MS Experiments” on page 24.
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Setting Up for Tuning the Mass Spectrometer

Tune your NSI/MS system to maximize its ion signal intensity. Because tuning optimizes ion 
transport, which is affected by the ion source conditions, it is important to tune the mass 
spectrometer with the NSI source connected. You can tune your mass spectrometer with any 
of the three interchangeable NSI probes.

If you are using the static NSI probe, the setup for tuning and general operation are the same. 
In both cases, you first fill the static emitter with solution. You then reassemble the NSI 
probe, reattach the NSI source to the mass spectrometer, and reconnect the gas inlet of the 
NSI probe to the syringe pump. Before you begin your sample analysis or the automated 
tuning procedure, you optimize the position of the emitter tip.

If you want to tune your NSI/MS system with either the dynamic NSI probe or the 
packed-tip NSI probe, you need to remove the capillary column or the packed-tip emitter 
from the probe, and then attach the probe to the syringe pump. 

After you set up your NSI/MS for tuning as described in this chapter, proceed to the tuning 
chapter in this manual that applies to your mass spectrometer.

Contents

• Creating a Syringe Adapter

• Connecting the Static NSI Probe to the Syringe Pump

• Connecting the Dynamic NSI Probe to the Syringe Pump

• Connecting the Packed-Tip Probe to the Syringe Pump
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Creating a Syringe Adapter
Creating a Syringe Adapter
The syringe adapter consists of a piece of 0.007 in. ID Teflon™ tubing and a fingertight fitting 
(see Figure 65).

Figure 65. Syringe assembly

To create a syringe adapter 

1. Cut a 4 to 5 cm length of 0.007 in. ID Teflon tubing. 

2. Insert the syringe needle into the Teflon tubing until the end of the needle is flush with 
the end of the tubing. The needle serves to prevent the tubing from collapsing when you 
swage on the ferrule.

3. Slip a fingertight nut and ferrule onto the Teflon tubing. Insert the tubing and fittings 
into a PEEK union. Then, tighten the nut finger tight to swage on the ferrule. 

4. Remove the needle from the tubing. Unscrew the nut and verify that the ferrule is swaged 
onto the tubing. Then, reconnect the syringe adapter to the PEEK union.

Connecting the Static NSI Probe to the Syringe Pump
The syringe pump provides backpressure to the static NSI probe. 

To connect the static NSI probe to the syringe pump

1. Prepare a syringe adapter as described in the previous section, “Creating a Syringe 
Adapter.” 

2. Connect the syringe adapter to a PEEK union.

3. Cut a 40 to 50 cm length of 0.030 in. ID Teflon tubing.

4. Use a fingertight nut and ferrule to connect one end of the 0.030 in. ID Teflon tubing to 
the PEEK union. 

5. Use a flangeless nut and a flangeless ferrule to connect the other end of the 0.030 in. ID 
Teflon tubing (see Figure 66) to the gas inlet (see Figure 67)of the static NSI probe. 

PEEK Union Fingertight Nut 50 mL Syringe

Ferrule Teflon Tube
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Connecting the Static NSI Probe to the Syringe Pump
Figure 66. Syringe line

Figure 67. View of the static NSI probe, showing the gas inlet

Flangeless 
Ferrule

Flangeless 
Nut

PEEK Union and 
Fingertight fittings

Teflon Tubing 
(0.007-in. ID)

Teflon Tubing 
(0.030 in. ID)

Gas Inlet
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7 Setting Up for Tuning the Mass Spectrometer
Connecting the Dynamic NSI Probe to the Syringe Pump
6. Slip the syringe needle into the free end of the syringe adapter. Then, insert the empty 
syringe into the syringe pump on the front of your mass spectrometer as follows:

• For an LCQ Deca, LCQ Duo, or LCQ Advantage mass spectrometer, insert the 
syringe into the syringe holder of the syringe pump. Press the black release button on 
the syringe pump handle. Then, move the handle forward until it just contacts the 
syringe plunger.

• For an LCQ Deca XP Plus or LTQ Series mass spectrometer, insert the syringe into 
the syringe holder of the syringe pump. Squeeze the blue release levers on the pusher 
block. Then, slide the pusher block forward until it just contacts the syringe plunger.

• For a TSQ Quantum Series mass spectrometer, insert the syringe into the syringe 
holder of the syringe pump. Press the black release button on the syringe pump 
handle. Then, lower the handle until it just contacts the syringe plunger.

Connecting the Dynamic NSI Probe to the Syringe Pump
To tune your NSI/MS system using the dynamic NSI probe, you must first assemble the 
dynamic NSI probe with a tuning adapter instead of a column adapter, and then connect the 
tuning adapter to the mass spectrometer’s syringe pump.

To prepare an NSI/MS system with a dynamic NSI probe for tuning

1. Assemble the dynamic NSI probe with a tuning adapter as described in “Assembling the 
Dynamic NSI Probe” on page 49.

2. Insert the dynamic NSI probe into the base mount of the NSI source, and then reconnect 
the NSI source to the mass spectrometer.

3. Create a syringe adapter as described in “Creating a Syringe Adapter” on page 68.

4. Fill a 50 μL syringe with an appropriate tuning solution. For instructions on preparing an 
appropriate tuning solution, see Appendix C, “Tuning Solutions for the NSI Mode.” 

5. Slip the syringe needle into the free end of the syringe adapter, and then insert the empty 
syringe into the syringe pump on the front of your mass spectrometer as follows:

• For an LCQ Deca, LCQ Duo, or LCQ Advantage mass spectrometer, insert the 
syringe into the syringe holder of the syringe pump. Press the black release button on 
the syringe pump handle. Then move the handle forward until it just contacts the 
syringe plunger.

• For an LCQ Deca XP Plus or LTQ Series mass spectrometer, insert the syringe into 
the syringe holder of the syringe pump. Squeeze the blue release levers on the pusher 
block. Then slide the pusher block forward until it just contacts the syringe plunger.

• For a TSQ Quantum Series mass spectrometer, insert the syringe into the syringe 
holder of the syringe pump. Press the black release button on the syringe pump 
handle. Then lower the handle until it just contacts the syringe plunger.
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Connecting the Dynamic NSI Probe to the Syringe Pump
6. Using the appropriate fittings, connect a transfer line between the ZDV stainless steel 
union that is connected to back end of the dynamic NSI probe and the PEEK union that 
is connected to the syringe adapter. See Figure 68.

Figure 68. Connecting the dynamic NSI probe to the syringe pump

Transfer line 
with fittings

ZDV 
stainless steel 
union

Adaptor nut

PEEK union Teflon tube

Fingertight 
fitting

50 μL syringe
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7 Setting Up for Tuning the Mass Spectrometer
Connecting the Packed-Tip Probe to the Syringe Pump
Connecting the Packed-Tip Probe to the Syringe Pump
To tune your NSI/MS system using the packed-tip NSI probe, you must replace the PicoFrit 
column with a TaperTip™ emitter. Then, using the appropriate fittings and tubing, connect 
the ground junction on the back of the probe to the syringe pump on the front of the mass 
spectrometer. See Figure 69.

Figure 69. Connection between the syringe pump and the packed-tip NSI probe

To prepare an NSI/MS system with a dynamic NSI probe for tuning

1. Remove the cover from the body of the packed-tip NSI probe.

2. Pull the liquid junction out of the spring retainer.

3. Unscrew the packed-tip emitter from the Voltage Junction of the packed-tip NSI probe 
and replace it with a TaperTip™ emitter. 

4. Insert the packed-tip NSI probe into the base mount of the NSI source. Then, reconnect 
the NSI source to the mass spectrometer.

5. Prepare a syringe adapter as described in “Creating a Syringe Adapter” on page 68.

6. Fill a 50 μL syringe with an appropriate tuning solution. For instructions on preparing an 
appropriate tuning solution, refer to Appendix C, “Tuning Solutions for the NSI Mode.” 

7. Slide the syringe needle into the free end of the syringe adapter. Then, insert the empty 
syringe into the syringe pump on the front of your mass spectrometer as follows:

• For an LCQ Deca, LCQ Duo, or LCQ Advantage mass spectrometer, insert the 
syringe into the syringe holder of the syringe pump. Press the black release button on 
the syringe pump handle. Then, move the handle forward until it just contacts the 
syringe plunger.

• For an LCQ Deca XP Plus or LTQ Series mass spectrometer, insert the syringe into 
the syringe holder of the syringe pump. Squeeze the blue release levers on the pusher 
block. Then, slide the pusher block forward until it just contacts the syringe plunger.

Note  You can order a TaperTip emitter from New Objective, Inc.

Ground junction of the 
packed-tip NSI Probe

Fingertight fitting 50 μL syringe

Short head nut PEEK union Teflon tube
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• For a TSQ Quantum Series mass spectrometer, insert the syringe into the syringe 
holder of the syringe pump. Press the black release button on the syringe pump 
handle. Then, lower the handle until it just contacts the syringe plunger.

8. Using the Short Head Nut and a ferrule, connect one end of a transfer line to the Ground 
Junction on the back of the packed-tip NSI probe. Using the appropriate fittings, connect 
the other end of the transfer line to the PEEK union that is connected to the syringe 
adapter.
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Tuning an LCQ Series Mass Spectrometer

The Tune Plus application program is used to determine and optimize the instrument control 
parameters for an LCQ Series mass spectrometer.

The procedures in this chapter assume that you are familiar with your mass spectrometer and 
Xcalibur software. For additional information, refer to the data system Help or the Getting 
Connected Guide and Hardware Manual for your mass spectrometer.

Tuning an LCQ Series Mass Spectrometer in the Static NSI Mode
The procedures in this section apply to the static NSI mode and assume that you have already 
installed the static NSI probe and connected its gas inlet to the syringe pump of your 
LCQ Series mass spectrometer. For instructions on installing the static NSI source, refer to 
Chapter 6. For instructions on assembling the static NSI probe, refer to “Assembling the 
Static NSI Probe” on page 44.

To tune your LCQ Series mass spectrometer in the static NSI mode, follow these procedures: 

1. Setting Up the LCQ Series Mass Spectrometer for the Static NSI/MS Mode

2. Initiating Flow for Static Nanospray

3. Determining the Threshold and Operating Spray Voltage for the Static Nanospray Mode

4. Optimizing the Emitter Position for Static Nanospray

5. Automatically Optimizing the Voltages for Ion Detection in the Static NSI Mode

Tip  You can tune your system in either the static or dynamic nanospray mode prior to 
performing dynamic nanospray experiments. Tuning your NSI/MS system with the static 
NSI probe allows you to avoid contaminating the liquid junction of the dynamic NSI 
probe with the tuning solution.

Contents

• Tuning an LCQ Series Mass Spectrometer in the Static NSI Mode

• Tuning an LCQ Series Mass Spectrometer in the Dynamic NSI Mode
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Tuning an LCQ Series Mass Spectrometer in the Static NSI Mode
Setting Up the LCQ Series Mass Spectrometer for the Static NSI/MS Mode

To set up your LCQ Series mass spectrometer for the static NSI/MS mode from the 
Tune Plus application program

1. From the computer desktop, click the Tune icon to open the Tune Plus window. 

2. On the Control / Scan Mode toolbar, which is the second toolbar from the top in the 
Tune Plus window, click the On/Standby button to turn on your LCQ Series mass 
spectrometer.

3. If it is not already selected, select NSI as the API source as follows:

a. From the Tune Plus menu, choose Setup > Change API Source Type to open the 
Change Source Type dialog box shown in Figure 70.

Figure 70. Change Source Type dialog box

b. Select the NSI option button.

c. Click OK to close the Change Source Type dialog box.

4. From the Instrument Setup toolbar, click the API Source button to open the NSI Source 
dialog box. See Figure 71.

On Standby Off

Nanospray option
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Figure 71. NSI Source dialog box

5. Ensure that the setting for the spray voltage is at (±)1.0 kV and that the setting for the 
sheath gas flow rate is at 0. Sheath gas is not used for a static NSI source.

Initiating Flow for Static Nanospray

Thermo Fisher Scientific recommends these settings for initiating static nanospray flow are as 
follows:

• Distance from the spray tip to the ion transfer capillary: ~2 mm

• Spray voltage: (±)1.0 kV

To initiate the flow for static nanospray

1. Using the imaging system or by visual inspection, ensure that the tip is approximately 
2 mm away from the ion transfer tube. 

2. If the NSI Source dialog box is not already open, open it.

3. Verify that the spray voltage is set to (±)1.0 kV.

4. Click Apply to download the parameters.

IMPORTANT      When switching to nanospray mode or when switching the ion 
polarity while operating in nanospray mode (for example, from positive ion mode to 
negative ion mode), an electrical arc might be created between the tip of the 
nanospray needle and the ion sweep cone if the initial spray voltage is set too high. To 
prevent arcing, increase the distance between the tip of the needle and the ion sweep 
cone or turn off the spray voltage and unplug the high voltage cable.
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5. If you are using the syringe pump to provide backpressure, turn it on from the 
Syringe Pump dialog box. Allow the pump to run for approximately 5 seconds, then stop 
the pump and keep the syringe in place. For instructions on connecting a syringe line to 
the static NSI probe, refer to “Connecting the Static NSI Probe to the Syringe Pump” on 
page 68.

6. Set the scan parameters for tuning as follows:

a. Click the Define Scan button to open the Define Scan dialog box.

b. In the Scan Description group box, select the Full option button for the Scan Type.

c. In the Scan Ranges Group box, set the scan range to begin at 400 m/z and end at 
2000 m/z.

d. In the Scan Time group box, make the following entries:

i. In the Number of Microscans combo box, type 3 to set the total number of 
microscans to 3.

ii. In the Maximum Inject Time combo box, type 200 to set the maximum 
injection time to 200 ms.

e. Click Apply to download the parameters. 

f. Click OK to close the Define Scan dialog box.

7. Click the Injection Control toolbar button to open the Injection Control dialog box.

8. Verify the parameters are set to the following values. Change the values if needed:

a. AGC is set to On.

b. Full Scan MS Target is set to 1e+008.

c. SIM Scan Mode Target is set to 2e+007.

d. MSn Scan Mode Target must be set to 4e+007.

e. Zoom Target must be set to 4e+007.

f. Inject WaveForm is set to Off.

g. Click Apply and OK to accept these values.

9. If necessary, click the Centroid/Profile button to toggle the data type to centroid. (The 
Centroid state of the button is shown on the left.)

10. Ensure that the polarity is set to the appropriate mode for your tuning compound. If 
necessary, click the Positive/Negative Polarity button to toggle the ion polarity mode.

Note  Use the minimum required syringe pump setting to initiate static nanospray.
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Determining the Threshold and Operating Spray Voltage for the Static Nanospray 
Mode

To determine the threshold spray voltage and the operational spray voltage for static 
nanospray

1. In the Tune Plus window, display the Spectrum view by clicking the Display Spectrum 
View button on the File/Display tool bar.

2. With the mass spectrometer On, observe the mass spectrum of the test solution in the 
Spectrum View of the Tune Plus window. If MRFA is used as the tuning solution, the 
peak of interest will be at m/z 524.30.

3. From the NSI Source dialog box, gradually increase (decrease if operating in negative 
polarity mode) the spray voltage in 50 V (0.05 kV) increments until the signal of the ion 
at m/z 524.30 is observed in full scan MS mode. Record this voltage as the threshold 
nanospray voltage. Typical values of the voltage for initiating spray vary from (±)1.0 to 
2.0 kV.

4. Further increase the spray voltage setting to 100 to 200 V above the threshold voltage to 
ensure that stable nanospray is obtained. This nanospray voltage typically ranges from 
(±)1.2 to 2.2 kV.

Optimizing the Emitter Position for Static Nanospray

To set the emitter position while monitoring the signal intensity of the ion of interest

1. Initiate the manual tuning process for the mass-to-charge ratio of the ion of interest as 
follows:

a. On the Control/Scan Mode tool bar in the Tune window, click the Tune button to 
display the Tune dialog box.

b. Click the Manual tab to display the Manual page. 

c. In the Mass spin box, type in the mass-to-charge ratio for MRFA (m/z 524.30) or the 
mass-to-charge ratio of interest for your tuning solution and select the adjacent check 
box. 

d. Click Start. A message box displays the following message: Ensure that the syringe is 
full. Click OK to close the message box and return to the Tune dialog box.

2. On the File/Display toolbar, click the Graph View button to monitor the intensity of the 
ion of interest using the Graph View.

3. Slightly turn the “X” and “Y” adjustment knobs on the XYZ stage to fractionally adjust 
the tip position for signal optimization.

IMPORTANT      Spray voltages above (±)2.5 kV might cause arcing between the 
emitter tip and the ion transfer tube surface. This might damage the emitter coating.
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4. Decrease or stop the syringe pump. The syringe pump speed should be set to the lowest 
possible value that can maintain a stable analyte signal. The backpressure required to 
initiate the spray is often higher than the one to maintain the spray. Decreasing the 
syringe pump speed typically results in a decreased flow rate and increased analysis time. 

5. When you are satisfied with the signal intensity, click Stop to end the manual tune 
process.

Automatically Optimizing the Voltages for Ion Detection in the Static NSI Mode

To automatically optimize the voltages for ion detection in the static NSI mode

1. On the Control/Scan Mode tool bar in the Tune window, click the Tune button to 
display the Tune dialog box. 

2. Initiate the automatic tuning process for the ion of interest in your tuning solution:

a. In the Tune dialog box, click the Automatic tab to display the Automatic page. 

b. In the Mass spin box, type 524.30 for MRFA to specify a tune value of m/z 524.30 or 
enter the mass-to-charge ratio for the ion of interest in your tuning solution.

c. Click Start.
Voltages for the ion transfer tube, the tube lens offset, ion lenses, and multipoles 
are automatically optimized.

3. Choose File > Save As to display the Save As dialog box and save the values of the 
optimized ion detection parameters in a Tune Method. 

Your LCQ Series mass spectrometer is now successfully tuned in the static NSI/MS mode 
using a standard tuning solution. Recall the Tune Method and use it as a starting point for 
optimizing on a different analyte of interest or for acquiring data.

Note  For the maximum analysis time, turn off the syringe pump after the spray is 
initiated. The electrospray process itself will maintain a stable flow.

Note  The Tune Method created by following the procedures in this section is specific 
to the NSI source. This method will not be optimum for standard electrospray.
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Tuning an LCQ Series Mass Spectrometer in the Dynamic NSI Mode
This section describes the operation of the Thermo Scientific NSI source in the dynamic NSI 
mode on a LCQ Series mass spectrometer using the Tune Plus application program.

You need to connect the syringe pump on the front of your mass spectrometer to your 
dynamic NSI probe or your packed-tip NSI probe to perform the tuning experiment.

Table 8 displays method parameters for operation of a LCQ Series mass spectrometer. As you 
progress to smaller ID columns (micro-capillary to nano-capillary), the suggested flow rate, 
emitter tip ID, and capillary temperature decrease. 

To tune your dynamic nanospray system, follow these procedures:

1. Preparing for Direct Infusion of the Tuning Solution

2. Setting Up the LCQ Series Mass Spectrometer for the Static NSI/MS Mode

3. Initiating Dynamic Nanospray by Using the Syringe Pump

4. Determining the Dynamic Nanospray Threshold and Operational Spray Voltages

5. Optimizing the Emitter Position for Dynamic Nanospray

6. Automatically Optimizing the Voltages for Ion Detection in the Dynamic NSI Mode

Note  The values listed in Table 8 can vary significantly from emitter to emitter. Refer to 
these values as guidelines, not specifications. 

Table 8. LC/NSI/MS Parameters for a LCQ Series mass spectrometer

Column ID Flow Rate Tip ID* Emitter Position† Capillary Temperature

50 μm <100 to 300 (nL/min) 5 to 15 μm approx. 1 mm 100 to 180 °C

75 μm 150 to 800 (nL/min) 10 to 20 μm 1 to 2 mm 130 to 200 °C

180 μm 0.30 to 1.0 (μL/min) 20 to 30 μm 2 to 3 mm 150 to 250 °C

320 μm 1.0 to 5.0 (μL/min) 30 to 75 μm 3 to 5 mm 150 to 250 °C
* The size of the tip ID is chosen based on PicoTips information provided by New Objective, Inc., Cambridge, Massachusetts. For more product 

information on the various tip sizes and types, see New Objective’s catalogs or web site (http://www.newobjective.com).
† Refers to the distance of the emitter tip from the surface of the ion transfer tube
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Preparing for Direct Infusion of the Tuning Solution

Use syringe pump on the front panel of your LCQ Series mass spectrometer as the tuning 
inlet. The syringe pump allows you to infuse a sample solution into the NSI source for 
extended periods of time. See Figure 72. 

Figure 72. LCQ Series mass spectrometer set up for tuning with the dynamic NSI source

For instructions on connecting either the dynamic NSI probe or the packed-tip probe to the 
syringe pump, see Chapter 7.

See Table 3 on page 16 to find the appropriate flow rate for the selected emitter tip ID.

Tune the NSI/LCQ Series MS system with a test solution of either 1 to 5 pmol/μL MRFA in 
(50:50) 1% acetic acid in methanol / water or a tuning solution with a sample concentration 
of 1 to 5 pmol/μL. For instructions on preparing a tuning solution for your NSI/MS system, 
refer to “Tuning Solution for LCQ Series and LTQ Series Mass Spectrometers” on page 146 
on page 146.

Setting up the Mass Spectrometer for Dynamic NSI/MS Operation

To set up the LCQ Series mass spectrometer for dynamic nanospray

1. Open the Tune Plus window. 

2. From the Control/Scan Mode toolbar, click the On/Standby button to turn on the mass 
spectrometer.

 

On Standby OffStandby
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3. If it is not already selected, select NSI as the API source as follows:

a. From the Tune Plus menu, choose Setup > Change API Source Type to open the 
Change Source Type dialog box shown in Figure 73.

Figure 73. Change Source Type dialog box

b. Select the NSI option button.

c. Click OK to close the Change Source Type dialog box.

4. If the Instrument Setup toolbar is not displayed, display it by choosing View > 
Instrument Setup. From the Instrument Setup toolbar, click the API Source button to 
open the NSI Source dialog box.

5. Settings in the NSI Source dialog box should approximate those in Figure 71 on page 77. 

6. Since neither are used with dynamic nanospray, set the auxiliary and sheath gas values 
to 0.

7. To set the scan parameters, do the following:

a. Click the Define Scan button to open the Define Scan dialog box.

b. Set the Scan Type to Full with a Scan Range of approximately 400 to 2000.

c. Set the number of microscans to 3, for the LCQ Series mass spectrometer, and set the 
maximum ion inject time to 200 ms.

d. Click Apply and close the Define Scan dialog box.

e. If necessary, click the Centroid/Profile button to toggle the data type to centroid. 
(The correct state of the button is shown on the left.)

f. Ensure that the polarity is set to the appropriate mode for your tuning compound. 
If necessary, click the Positive / Negative Polarity button to toggle the ion polarity 
mode.

Note  Follow the guidelines provided in Table 8 for setting the capillary temperature.
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Initiating Dynamic Nanospray by Using the Syringe Pump

To initiate the dynamic nanospray by using the syringe pump

1. In the Tune Plus window, click the Syringe Pump button to display the Syringe Pump 
dialog box.

2. In the (syringe) Type group box select the Other option button. This enables the Syringe 
ID spin box. Choose 1.030 mm for the Syringe ID to match the diameter of the 50 μL 
syringe (P/N 00301-19014) used in the infusion experiment.

3. In the Flow Control group box, type 1.00 in the Flow Rate spin box to set the flow rate to 
1 μL/min. Select the On option button to start the pump. Click OK to apply the 
parameters and to close the dialog box. 

Figure 74 shows the appropriate settings for the syringe pump.

Figure 74. Syringe pump settings

4. Watch the emitter tip with the imaging system for the appearance of the spray. It will take 
several minutes for the test solution to fill the system. 

5. If necessary, click the On / Standby button to turn on the mass spectrometer.

6. Check that the emitter tip is 2 to 5 mm from the ion transfer tube. 

You can view the emitter tip position from the imaging system or the window on the 
right-side of the Ion MAX adapter.

7. From the API Source dialog box, verify that the spray voltage is (±)1.0 kV. 

On OffStandby
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Determining the Dynamic Nanospray Threshold and Operational Spray Voltages

To determine the appropriate threshold and operational spray voltages

1. In the Tune Plus window, display the spectrum view by clicking the Display Spectrum 
View button on the File/Display toolbar.

2. Observe the test solution mass spectrum; if MRFA is used as the test solution, the peak of 
interest will be at m/z 524.30.

3. Open the NSI Source dialog box by clicking the API Source button. Then, increase the 
spray voltage gradually in 50 V (0.05 kV) increments. When the ion signal at m/z 524.30 
(or the m/z for your tuning compound) shows in the full scan MS mode, record the 
voltage setting as the threshold nanospray voltage. The threshold voltage for initiating 
spray varies from (±)1.0 to 2.0 kV and depends, in part, on the syringe pump speed.

4. Increase the spray voltage setting to 100 to 200 V above the threshold value to ensure 
stability of the nanospray. This nanospray value typically falls between (±)1.2 to 2.2 kV.

5. If no signal is noted and voltage has been raised beyond (±)2.2 kV, turn off the voltage 
and check the emitter tip for droplets. If none are present a clogged tip is likely. For more 
information on troubleshooting your dynamic NSI system, refer to “Troubleshooting 
Dynamic Nanospray” on page 118.

Optimizing the Emitter Position for Dynamic Nanospray

You can optimize the emitter position by monitoring the signal intensity of the ion of interest 
using the Spectrum view in the Tune Plus window.

To optimize the emitter position 

1. On the Control/Scan Mode tool bar, click the Tune button to display the Tune dialog 
box. Then click the Manual tab to display the Manual page. 

2. In the Mass spin box, type in the mass-to-charge ratio for MRFA (m/z 524.30) or the 
mass-to-charge ratio of interest for the tuning solution and select the adjacent check box.

3. Click Start. A message box displays the following message: Ensure that the syringe is full. 
Click OK to close the message box and return to the Tune dialog box.

Tip   For dynamic LC-NSI-MS experiments, the threshold voltage depends on both 
the column flow rate and the mobile phase composition. The threshold spray voltage 
value increases as the surface tension of the mobile phase and the column flow rate 
increase. The surface tension of MeOH, ACN, and Water are 0.0226 N/m, 
0.030 N/m, and 0.073 N/m, respectively.

IMPORTANT      Voltage settings above (±)2.5 kV might cause arcing between the 
emitter tip and the ion transfer tube surface.
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4. On the File/Display toolbar, click the Display Graph View button to monitor the 
intensity of the ion of interest using the Graph View.

5. Turn slightly the X and Y knobs of the XYZ stage to fractionally adjust the tip position for 
signal optimization, if necessary.

6. When the signal is satisfactory, click Stop to end the manual tune process.

Automatically Optimizing the Voltages for Ion Detection in the Dynamic NSI Mode 

You can optimize the voltage settings for the ion transport elements while monitoring signal 
intensity of the ion of interest in the Spectrum View of the Tune Plus window.

To automatically optimize the voltages for ion detection in the dynamic NSI mode

1. In the Tune dialog box, click the Automatic tab to display the Automatic page. 

2. In the What to Optimize On group box, select the Mass option button and type in the 
spin box either 524.30 (the mass-to-charge ratio for MRFA) or the mass-to-charge ratio 
for the ion of interest in your tuning solution. 

3. Click Start. A message box displays the following message: Ensure that the syringe is full. 
Click OK and return to the Tune dialog box.

4. Observe the Tune Plus window and the Tune dialog box during automatic tuning. The 
ion transfer tube, the tube lens offset, ion lenses and multipoles will have their voltage 
levels automatically optimized.

5. Choose File > Save As and save the values of the optimized parameters in a Tune method.

Your LCQ Series mass spectrometer is now tuned in the NSI/MS mode. The Tune Method 
that you created by following the instructions in this section can be recalled and used as a 
starting point for optimization in the dynamic NSI/MS mode either for a different analyte or 
for loop injections.

Note  The Tune Method created by following the procedures in this section is specific 
to dynamic nanospray with the particular operating conditions that were used. This 
method will not be optimum for static nanospray or standard electrospray.
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Tuning an LTQ Series Mass Spectrometer

The Tune Plus application program is used to determine and optimize the instrument control 
parameters for an LTQ Series mass spectrometer.

The procedures in this chapter assume that you are familiar with your mass spectrometer and 
Xcalibur software. If you need additional information, refer to the Online Help, Getting 
Connected Guide, and/or MS detector Hardware Manual for your mass spectrometer.

If you have just installed an NSI source, ensure that the NSI mode is selected by following the 
instructions in the first section of this chapter. Then, proceed to the section that describes 
how to perform the tuning experiment for your nanospray application.

Selecting NSI as the API Source
After you install an NSI source on your mass spectrometer, ensure that the NSI mode of 
operation is selected for the instrument configuration.

Tip  You can tune your system in either the static or dynamic nanospray mode prior to 
performing dynamic nanospray experiments. Tuning your NSI/MS system with the static 
NSI probe allows you to avoid contaminating the liquid junction of the dynamic NSI 
probe with the tuning solution.

Contents

• Selecting NSI as the API Source

• Tuning an LTQ Series Mass Spectrometer in the Static NSI/MS Mode

• Tuning an LTQ Series Mass Spectrometer in the Dynamic NSI Mode
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Selecting NSI as the API Source
To configure the LTQ Series mass spectrometer for the NSI mode

1. From the Windows taskbar, depending on the data system version, do one of the 
following:

• For Xcalibur 2.0.7 or lower, choose Start > Programs > Xcalibur > Instrument 
Configuration.

The Instrument Configuration application appears.

–or–

• For Xcalibur 2.1.x, choose Start > Programs >Thermo Foundation 1.0 > 
Instrument Configuration.

The Thermo Foundation Instrument Configuration dialog box appears.

2. Click the LTQ MS icon in the Configured Devices area to open the LTQ Configuration 
dialog box.

3. Click the Ion Source listing in the directory tree.

4. From the Default Source list box, select Nanospray. See Figure 75.

Figure 75. LTQ Configuration dialog box, showing Nanospray selected as the default source

5. Click the Service listing in the directory tree. 

6. In the list of Service items, ensure that the Enable Ion Source Identification check box is 
selected.

7. Click OK to exit the LTQ Configuration dialog box.

8. Click Done to exit the Instrument Configuration or Foundation application.

Note  The Instrument Configuration application has the same functionality as 
the Thermo Foundation Instrument Configuration dialog box. 
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Tuning an LTQ Series Mass Spectrometer in the Static NSI/MS Mode
The procedures in this section apply to the static NSI mode and assume that you have already 
installed the static NSI probe and connected its gas inlet to the syringe pump of your 
LTQ Series mass spectrometer. For instructions on assembling the static NSI probe, refer to 
“Assembling the Static NSI Probe” on page 44. For instructions on installing a static NSI 
source, see to Chapter 6.

To tune and calibrate your LTQ Series mass spectrometer in the static NSI mode, follow these 
procedures. 

1. Setting Up the Mass Spectrometer for Static NSI/MS Operation

2. Initiating Flow for Static Nanospray

3. Determining the Threshold and Operating Spray Voltage for the Static NSI Mode

4. Optimizing the Emitter Position for Static Nanospray

5. Automatically Optimizing the Voltages for Ion Detection in the Static NSI Mode

Setting Up the Mass Spectrometer for Static NSI/MS Operation

To set up your ion trap mass spectrometer for static NSI operation from the Tune Plus 
window

1. From the Windows desktop, click the Tune icon to open the Tune Plus window. 

2. On the Control/Scan Mode toolbar, which is the second toolbar from the top in the Tune 
Plus window, click the On/Standby button to turn on the LTQ Series mass spectrometer.

3. From the Instrument Setup toolbar, click the API Source icon to open the NSI Source 
dialog box. See Figure 76.

Figure 76. NSI Source dialog box

On Standby Off
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4. Ensure that the setting for the spray voltage is at (±)1.0 kV and that the setting for the 
sheath gas flow rate is at 0. Sheath gas is not used for a static NSI source.

Initiating Flow for Static Nanospray

Thermo Fisher Scientific recommends these settings for initiating static nanospray flow:

• Distance from the spray tip to the ion transfer capillary: ~2 mm

• Spray voltage: (±)1.0 kV

To initiate the flow for static nanospray

1. Using the imaging system or by visual inspection, ensure that the tip of the emitter is 
approximately 2 mm away from the ion transfer tube.

2. If you do not see the tip of the emitter on the screen of the imaging system, adjust its 
Z-axis position.

3. Open the NSI Source dialog box if it is not already open. 

4. From the NSI Source dialog box, ensure that the spray voltage is set to (±)1.0 kV. Then, 
click Apply. See Figure 76 on page 89.

5. If you are using a syringe to provide backpressure, turn on the syringe pump from the 
Syringe Pump dialog box. Allow the pump to run for approximately 5 seconds. Then, 
stop the pump and keep the syringe in place. For instructions on connecting a syringe line 
to the static NSI probe, refer to “Connecting the Static NSI Probe to the Syringe Pump” 
on page 68.

6. Set the scan parameters for tuning and optimization as follows:

a. Click the Define Scan button to open the Define Scan dialog box.

b. In the Scan Description group box, make the following selections:

• Select Normal from the Mass Range list box.

• Select Normal from the Scan Rate list box.

• Select Full from the Scan Type list box.

IMPORTANT      When switching to nanospray mode or when switching the ion 
polarity while operating in nanospray mode (for example, from positive ion mode to 
negative ion mode), an electrical arc might be created between the tip of the 
nanospray needle and the ion sweep cone if the initial spray voltage is set too high. To 
prevent arcing, increase the distance between the tip of the needle and the ion sweep 
cone or turn off the spray voltage and unplug the high voltage cable.

Note  Use the minimum required syringe pump setting to initiate static nanospray.
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c. In the Scan Ranges Group box, select From/To from the Input list box. Then, set the 
scan range to begin at 400 m/z and end at 2000 m/z.

d. In the Scan Time group box, make the following entries:

• Type 1 in the Microscans combo box to set the number of microscans to 1.

• Type 200 in the Max Inject Time combo box to set the maximum ion inject time 
to 200 ms.

e. In the Source Fragmentation group box, confirm that the Turn On check box in not 
selected to specify that the ion source fragmentation option is turned off.

f. Click Apply to download these settings to the mass spectrometer. Then, click OK to 
close the Define Scan dialog box.

7. If necessary, click the Centroid/Profile button to toggle the data type to centroid. (The 
Centroid state of the button is shown on the left.)

8. Ensure that the polarity is set to the appropriate mode for your tuning compound. If 
necessary, click the Positive/Negative Polarity button to toggle the ion polarity mode.

Determining the Threshold and Operating Spray Voltage for the Static NSI Mode

To determine the threshold spray voltage and the operational spray voltage for static 
nanospray

1. In the Tune Plus window, display the Spectrum view by clicking the Display Spectrum 
View button on the File/Display tool bar.

2. With the mass spectrometer On, observe the mass spectrum of the test solution in the 
Spectrum View of the Tune Plus window. If MRFA is used as the test solution, the peak 
of interest will be at m/z 524.30.

3. Click the NSI Source icon to open the NSI Source dialog box. Then, gradually increase 
(decrease if operating in negative polarity mode) the spray voltage in 50 V (0.05 kV) 
increments until a signal for the ion at m/z 524.30 is observed in full scan MS mode. 
Record this voltage as the threshold nanospray voltage.

Typical spray voltage values for initiating spray vary from (±)1.0 to 2.0 kV.

4. Further increase the spray voltage setting to 100 to 200 V above the threshold voltage to 
ensure that stable nanospray is obtained. This nanospray voltage typically ranges from 
(±)1.2 to 2.2 kV.

Note  Spray voltages above (±)2.5 kV might cause arcing between the emitter tip and 
the ion transfer tube surface. This might damage the emitter coating.
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Optimizing the Emitter Position for Static Nanospray

To set the emitter position, while monitoring the signal intensity of the ion of interest

1. Initiate the manual tuning process for the mass-to-charge ratio of the ion of interest as 
follows:

a. On the Control/Scan Mode tool bar in the Tune window, click the Tune button to 
display the Tune dialog box. 

b. Click the Manual tab to display the Manual page. 

c. In the Mass spin box, type in the mass-to-charge ratio for MRFA (m/z 524.30) or the 
mass-to-charge ratio of interest for your tuning solution and select the adjacent 
check box. 

d. Click Start. A message box displays the following message: Ensure that the syringe is 
full. Click OK to close the message box and return to the Tune dialog box.

2. On the File/Display toolbar, click the Graph View button to monitor the intensity of the 
ion of interest using the Graph View.

3. Slightly turn the “X” and “Y” adjustment knobs on the XYZ stage to fractionally adjust 
the emitter tip position for signal optimization.

4. Decrease or stop the syringe pump. The syringe pump speed should be set to the lowest 
possible value that will maintain stable analyte signal. The backpressure required to 
initiate the spray is often higher than the one to maintain the spray. Decreasing the 
syringe pump speed typically results in a decreased flow rate and increased analysis time. 

5. When you are satisfied with the signal intensity, click Stop to end the manual tune 
process.

Automatically Optimizing the Voltages for Ion Detection in the Static NSI Mode

To automatically optimize the voltages for ion detection in the static NSI mode

1. On the Control/Scan Mode tool bar in the Tune window, click the Tune button to 
display the Tune dialog box. 

2. Initiate the automatic tuning process for the ion of interest in your tuning solution:

a. In the Tune dialog box, click the Automatic tab to display the Automatic page. 

b. In the Mass spin box, type 524.30 for MRFA to specify a tune value of m/z 524.30 or 
enter the mass-to-charge ratio for the ion of interest in your tuning solution.

c. Click Start. 

Tip  For the maximum analysis time, turn off the syringe pump after the spray is 
initiated. The electrospray process itself will maintain a stable flow.
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Examine the Tune plus window and the Tune dialog box while automatic tuning is in 
progress. Voltages for the ion transfer tube, the tube lens offset, ion lenses, and multipoles 
will be automatically optimized.

3. Choose File > Save As to display the Save As dialog box and save the values of the 
optimized ion detection parameters in a Tune Method. 

The mass spectrometer is now successfully tuned in NSI/MS mode using a standard tuning 
solution. Recall the Tune Method and use it as a starting point for optimizing the mass 
spectrometer using a different analyte of interest or for acquiring data.

Tuning an LTQ Series Mass Spectrometer in the Dynamic NSI Mode
The procedures in this section apply to the dynamic NSI mode and assume that you have 
already installed an NSI source containing either the dynamic NSI probe or the packed-tip 
NSI probe onto your mass spectrometer. 

Table 9 and Table 10 display the NSI method parameters for operation on a LTQ Series mass 
spectrometer. As you progress to smaller ID columns (micro-capillary to nano-capillary), the 
suggested flow rate, emitter tip ID, and capillary temperature decrease. 

Note  The Tune Method that you have created by following the procedures in this 
chapter is specific to static nanospray. This method will not be optimum for dynamic 
nanospray or standard electrospray.

Note  Thermo Fisher Scientific has discontinued the NSI-2 dynamic nanospray and 
packed-tip probes. For information about installing the NSI-1 dynamic nanospray probe, 
refer to the Dynamic Nanospray Probe (NSI-1) Installation Guide.

IMPORTANT      If you are transferring a nanospray method developed on an LTQ or 
LTQ XL mass spectrometer to an LTQ Velos mass spectrometer, raise the capillary 
temperature (for the ion transfer tube heater) by 50 °C. The minimum capillary 
temperature for the LTQ Velos mass spectrometer in the NSI mode is 250 °C.

IMPORTANT      When you are developing a nanospray method for the LTQ Velos mass 
spectrometer, use a minimum capillary temperature of 250 °C. Setting the capillary 
temperature below 250 °C could result in contamination of the ion source interface and 
more frequent maintenance of the ion transfer tube.
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To tune and calibrate an LTQ Series mass spectrometer in the dynamic NSI mode, follow 
these procedures:

1. Preparing for Direct Infusion of the Tuning and Calibration Solution

2. Setting up an LTQ Series Mass Spectrometer for Dynamic NSI/MS Operation

3. Initiating Dynamic Nanospray by with the Syringe Pump

4. Determining the Dynamic Nanospray Threshold and Operational Spray Voltages

5. Optimizing the Emitter Position for Dynamic Nanospray

6. Automatically Optimizing the Voltages for Ion Detection in the Dynamic NSI Mode

Note  The values listed in Table 9 and Table 10 can vary significantly from emitter to 
emitter. Refer to these values as guidelines, not specifications. 

The tip ID sizes are based on PicoTips information provided by New Objective, Inc., 
Cambridge, Massachusetts. See New Objective’s web site (http://www.newobjective.com)
or catalogs for more product information on the various tip sizes and types.

The emitter position refers to the distance of the emitter tip from the surface of the ion 
transfer tube.

Table 9. LC/NSI/MS parameters for an LTQ or LTQ XL mass spectrometer

Column Size Flow Rate Tip ID Emitter Position Capillary Temperature

50 μm <100 to 300 nL/min 5 to 15 μm Approx. 1 mm 100 to 180 °C

75 μm 150 to 800 nL/min 10 to 20 μm 1 to 2 mm 130 to 200 °C

180 μm 0.3 to 1.0 μL/min 20 to 30 μm 2 to 3 mm 150 to 250 °C

320 μm 1 to 5 μL/min 30 to 75 μm 3 to 5 mm 150 to 250 °C

Table 10. LC/NSI/MS parameters for an LTQ Velos mass spectrometer

Column Size Flow Rate Tip ID Emitter Position Capillary Temperature

50 μm <100 to 300 nL/min 5 to 15 μm Approx. 1 mm minimum 250 °C

75 μm 150 to 800 nL/min 10 to 20 μm 1 to 2 mm minimum 250 °C

180 μm 0.3 to 1.0 μL/min 20 to 30 μm 2 to 3 mm 250 to 300 °C

320 μm 1 to 5 μL/min 30 to 75 μm 3 to 5 mm 250 to 300 °C
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Preparing for Direct Infusion of the Tuning and Calibration Solution

Use the mass spectrometer’s syringe pump as the inlet for tuning. The syringe pump allows 
you to infuse a sample solution into the NSI source for extended periods of time. Figure 77 
shows the plumbing connections for NSI/MS sample introduction from the syringe pump. 
For detailed instructions on setting up your system for tuning, see Chapter 7.

See Table 3 on page 16 to find the flow rate appropriate to the emitter tip ID selected.

Tune your NSI/LTQ Series mass spectrometer with a test solution of either 1 to 5 pmol/μL 
MRFA in (50:50) 1% acetic acid in methanol / water or a tuning solution with a sample 
concentration of 1 to 5 pmol/μL.

Figure 77. LTQ mass spectrometer, showing dynamic NSI probe connected to the syringe pump

Setting up an LTQ Series Mass Spectrometer for Dynamic NSI/MS Operation

To set up the LTQ Series mass spectrometer for dynamic nanospray

1. Open the Tune Plus window. Click the On/Standby button to turn on the mass 
spectrometer.

2. From the Instrument Setup toolbar, click the API Source button to open the NSI Source 
dialog box.

3. Ensure that the settings in the NSI Source dialog box approximate those in Figure 76 on 
page 89. 

LTQ

On Standby Off
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4. Set auxiliary and sheath gas values to 0, since neither are used with dynamic nanospray.

5. Set the scan parameters as follows:

a. Click the Define Scan button to open the Define Scan dialog box.

b. Set the Scan Type to Full with a Scan Range of approximately 400 to 2000.

c. Set the number of microscans to 1 for the LTQ Series mass spectrometer, and set the 
maximum ion inject time to 200 ms.

d. Click Apply and close the Define Scan dialog box.

e. If necessary, click the Centroid / Profile button to toggle the data type to centroid. 
(The correct state of the button is shown on the left.)

f. Ensure that the polarity is set to the appropriate mode for your tuning compound. If 
necessary, click the Positive/Negative Polarity button to toggle the ion polarity mode.

Initiating Dynamic Nanospray by with the Syringe Pump

To initiate the dynamic nanospray with the syringe pump

1. In the Tune Plus window, click the Syringe Pump button to display the Syringe Pump 
dialog box. See Figure 78.

2. In the Type group box, select the Other option button. This enables the Syringe ID spin 
box. Choose 1.030 mm for the Syringe ID to match the diameter of the 50 μL syringe 
(P/N 00301-19014) used in the infusion experiment.

3. In the Flow Control group box, type 1.00 in the Flow Rate spin box to set the flow rate to 
1 μL/min. Select the On option button to start the syringe pump. Click OK to apply the 
parameters and to close the dialog box. 

Figure 78 shows the appropriate settings in the Syringe Pump dialog box.

Note  Follow the guidelines provided in Table 9 for setting the capillary temperature.
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Figure 78. Syringe pump settings

4. Click the On/Standby button to turn on the mass spectrometer if it is not already On.

5. From the imaging system, watch the emitter tip for the appearance of the spray. It will 
take several minutes for the test solution to fill the system. 

6. Ensure that the emitter tip is 2 to 5 mm from the ion transfer tube.

You can view the emitter tip position from the imaging system or from the window on 
the right-side of the Ion MAX adapter. 

7. From the NSI Source dialog box, verify that the spray voltage is (±)1.0 kV. 

Determining the Dynamic Nanospray Threshold and Operational Spray Voltages

To determine the appropriate threshold and operational spray voltages

1. In the Tune Plus window, display the spectrum view by clicking the Display Spectrum 
View button on the File/Display toolbar.

2. Observe the test solution mass spectrum; if MRFA is used as the test solution, the peak of 
interest will be at m/z 524.30.

3. Open the NSI Source dialog box by clicking the NSI Source button. Then, increase the 
spray voltage gradually in 50 V (0.05 kV) increments. When the ion signal at m/z 524.30 
(or the m/z for your tuning compound) shows in the full scan MS mode, record the spray 
voltage setting as the threshold nanospray voltage. 

The threshold spray voltage for initiating spray varies from (±)1.0 to 2.0 kV and depends, 
in part, on the speed of the syringe pump.

On Standby Off
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4. Increase the spray voltage setting to 100 to 200 V above the threshold value to ensure 
stability of the nanospray. This nanospray value typically falls between (±)1.2 to 2.2 kV.

5. If no signal is noted and voltage has been raised beyond (±)2.2 kV, turn off the voltage 
and check emitter tip for droplets. If none are present a clogged tip is likely. For more 
information, refer to “Troubleshooting Dynamic Nanospray” on page 118.

Optimizing the Emitter Position for Dynamic Nanospray

You can optimize the emitter position for dynamic nanospray while monitoring the signal 
intensity of the ion of interest using the Spectrum view in the Tune Plus window.

To optimize the emitter position 

1. On the Control / Scan Mode tool bar, click the Tune button to display the Tune dialog 
box. Then, click the Manual tab to display the Manual page. 

2. In the Mass spin box, type in the mass-to-charge ratio for MRFA (m/z 524.30) or the 
mass-to-charge ratio of interest for the tuning solution and select the adjacent check box. 

3. Click Start. A message box displays the following message: Ensure that the syringe is full. 
Click OK to close the message box and return to the Tune dialog box.

4. On the File/Display toolbar, click the Display Graph View button to monitor the 
intensity of the ion of interest using the Graph View.

5. Turn slightly the “X” and “Y” knobs of the XYZ stage to fractionally adjust the tip 
position for signal optimization, if necessary.

6. When the signal is satisfactory, click Stop to end the manual tune process.

Tip  For dynamic LC-NSI-MS experiments, the threshold voltage depends on both 
the column flow rate and the mobile phase composition. The threshold spray voltage 
value increases as the surface tension of the mobile phase and the column flow rate 
increase. The surface tension of MeOH, ACN, and Water are 0.0226 N/m, 
0.030 N/m, and 0.073 N/m, respectively.

IMPORTANT       Voltage settings above (±)2.5 kV might cause arcing between the 
emitter tip and the ion transfer tube surface.
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Automatically Optimizing the Voltages for Ion Detection in the Dynamic NSI Mode 

You can optimize the voltage settings for the ion transport elements while monitoring signal 
intensity of the ion of interest in the Spectrum View of the Tune Plus window.

To automatically optimize the voltages for ion detection in the dynamic NSI mode

1. In the Tune dialog box, click the Automatic tab to display the Automatic page. 

2. In the What to Optimize On group box, select the Mass option button and type in the 
spin box either 524.30 (the mass-to-charge ratio for MRFA) or the mass-to-charge ratio 
for the ion of interest in your tuning solution.

3. Click Start. A message box displays the following message: Ensure that the syringe is full. 
Click OK and return to the Tune dialog box.

4. Observe the Tune Plus window and the Tune dialog box during automatic tuning. The 
ion transfer tube, the tube lens offset, ion lenses and multipoles will have their voltage 
levels automatically optimized

5. Choose File > Save As and save the values of the optimized parameters in a Tune method.

The mass spectrometer is now tuned in the NSI/MS mode. The Tune Method that you 
created by following the instructions in this section can be recalled and used as a starting point 
for optimization in the dynamic NSI/MS mode either for a different analyte or for loop 
injections.

Note  The Tune Method created by following the procedures in this section is specific 
to dynamic nanospray with the particular operating conditions that were used. This 
method will not be optimum for static nanospray or standard electrospray.
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Tuning a TSQ Series Mass Spectrometer

This chapter describes how to tune your TSQ™ Series mass spectrometer using an NSI source. 
You tune your TSQ Series mass spectrometer and determine the optimum settings for a 
specific compound from the Tune Master application. 

The procedures provided in this chapter assume that you are familiar with your mass 
spectrometer and Xcalibur software. If you need additional information, refer to the 
appropriate mass spectrometer Help, Getting Connected Guide, and/or MS detector 
Hardware Manual.

Tuning a TSQ Series Mass Spectrometer in the Static NSI Mode
To tune the TSQ Series mass spectrometer with a static NSI source, follow these procedures:

1. Setting up the Mass Spectrometer for Static NSI/MS Operation

2. Initiating Flow for Static Nanospray

3. Determining the Threshold and Operational Spray Voltages for Static Nanospray

4. Optimizing the Emitter Position for Static Nanospray

5. Optimizing Conditions for Ion Detection

Tip  You can tune your system in either the static or dynamic nanospray mode prior to 
performing dynamic nanospray experiments. Tuning your NSI/MS system with the static 
NSI probe allows you to avoid contaminating the liquid junction of the dynamic NSI 
probe with the tuning solution.

Contents

• Tuning a TSQ Series Mass Spectrometer in the Static NSI Mode

• Tuning a TSQ Series Mass Spectrometer in the Dynamic NSI Mode
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Setting up the Mass Spectrometer for Static NSI/MS Operation

To set up your TSQ Series mass spectrometer for static nanospray

1. Depending on the Xcalibur software version, open the tuning software by doing one of 
the following:

• From the computer desktop, double-click the Quantum Tune icon. The Tune Master 
window appears.

• From the taskbar, choose Start > Programs > Xcalibur > Quantum Tune. The 
Tune Master window appears.

• From the taskbar, choose Start > Programs > Thermo Instruments > TSQ > TSQ 
Tune. The Thermo TSQ EZ Tune – EZ Workspace appears.

2. From the Tune Master (or EZ Tune) window, click the On / Standby button to turn on 
the mass spectrometer. 

When you turn on your mass spectrometer, you initiate the following events:

• A high voltage is applied to the NSI probe.

• The mass spectrometer begins scanning.

• Tune Master (or EZ Tune) shows a real-time display in the Spectrum view.

3. From the menu, choose Setup > Change Ion Source > NSI.

4. On the Control/Scan Mode toolbar in the Tune Master window, click the Optimize 
Compound Dependent Devices button to open the Optimize Compound Dependent 
Devices view. Or, choose Display > Compound Dependent Devices from the menu. See 
Figure 79.

On Standby Off
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Figure 79. Optimize Compound Dependent Devices view

5. From the Compound Dependent Devices view, do the following:

a. If the Spray Voltage is not already set to (±)1 kV, click Spray Voltage in the Device 
Display box. Then, enter a value of (±)1000 in the Device spin box.

b. If the Sheath Gas Pressure is not already set to 0 units, click Sheath Gas Pressure in 
the Device Display box. Then, enter a value of 0 in the Device spin box.

c. Click Apply.

Initiating Flow for Static Nanospray

Thermo Fisher Scientific recommends these parameters for initiating static nanospray flow:

• Distance from the spray tip to the ion transfer capillary:  ~2 mm

• Nanospray voltage: (±)1.0 kV

To initiate the flow for static nanospray 

1. Ensure that your TSQ Series mass spectrometer is On.

2. Using the imaging system, or by visual inspection, ensure that the emitter tip is 
approximately 2 mm away from the ion transfer tube.

3. From the Compound Dependent Devices view, verify that the Spray Voltage is set to 
(±)1.0 kV.

Note  Sheath gas is not used for a static NSI source.
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4. If you are using the syringe pump to provide backpressure, click the Syringe Pump button 
to turn on the syringe pump. Allow the pump to run for approximately 5 seconds. Then, 
stop the syringe pump and keep the syringe in place.

5. Set the scan parameters for optimizing on your compound as follows:

a. Click the Define Scan button to display the Define Scan view. 

b. For Scan Type, click the Full Scan button to display the Scan Parameters group box.

c. In the Scan Range group box, select the FM/LM option button. 

d. In the First Mass spin box, type 50 to set the low endpoint of the scan range to 50 u. 

e. In the Last Mass spin box, type 1500 to set the high endpoint of the scan range to 
1500 u.

f. Click Apply.

6. If necessary, click the Centroid/Profile button on the Control/Scan Mode toolbar to 
toggle the data type to centroid. (The Centroid state of the button is shown on the left.)

7. Ensure that the polarity is set to the appropriate mode for you tuning compound. If 
necessary, click the Positive/Negative Polarity button on the Control / Scan Mode toolbar 
to toggle the ion polarity mode.

Determining the Threshold and Operational Spray Voltages for Static Nanospray 

To determine the operational voltage for static nanospray

1. In the Tune Master window (or EZ Tune), ensure that the Spectrum view is displayed. If 
it is not already displayed, choose View > Display Spectrum View to display it.

2. With the mass spectrometer On, observe the mass spectrum of the test solution. If 
polytyrosine is used as the test solution, the peak of interest will be at m/z 508.208.

3. From the Compound Dependent Devices view, gradually increase (decrease if operating 
in negative polarity mode) the spray voltage in 50 V (0.05 kV) increments until you 
observe the signal of the ion at m/z 508.208 (or the mass-to-charge ratio of your tuning 
compound) in the full scan MS mode. Record this voltage as the threshold spray voltage. 
Typical values of the threshold voltage vary from (±)1.0 to 2.0 kV.

4. Further increase the spray voltage setting to 100 to 200 V above the threshold voltage to 
ensure that stable nanospray is obtained. This operational nanospray voltage typically 
ranges from (±)1.2 to 2.2 kV.

OFF ON

IMPORTANT      Voltage settings above (±)2.5 kV might cause arcing between the 
emitter tip and the ion transfer tube surface. This might damage the emitter coating.

Tip  For the maximum analysis time, turn off the syringe pump after the spray is 
initiated. The nanospray process itself will maintain a stable flow.
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Optimizing the Emitter Position for Static Nanospray

You can optimize the emitter position for static nanospray while monitoring the signal 
intensity of the ion of interest using the Spectrum view in the Tune Master (or EZ Tune) 
window.

To optimize conditions for static nanospray

1. On the Control/Scan Mode toolbar, click the Instrument Method Development 
Workspace button to display the Instrument Method Development workspace.

2. In the Scan Range group box, select the Center Mass option button for the Entry Mode. 
See Figure 80.

Figure 80. Scan Range group box, showing settings for polytyrosine

3. In the Center Mass spin box, type 508.208 for polytyrosine to specify a tune value of 
m/z 508.208. Alternatively, enter the mass-to-charge value for the ion of interest in your 
tuning solution.

4. Click Apply.

5. On the File/Display toolbar, click the Display TIC button to monitor the intensity of the 
ion of interest using the TIC view.

6. If necessary, slowly turn the X and Y adjustment knobs on the XYZ stage to fractionally 
adjust the tip position for signal optimization.

Optimizing Conditions for Ion Detection

To optimize conditions for ion detection

1. Open the Full Instrument Control workspace, if it is not already open by choosing 
Workspace > Full Instrument Control.

2. Open the Compound Optimization view by clicking the Compound Optimization 
button. 

3. In the Compound Optimization view, select the Custom option button for the 
Optimization Options. 

The Optimize Compound Dependent Devices view appears.

4. In the Optimize Compound Dependent Devices view, select all of the check boxes that 
correspond to optimizable items for your application.
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5. From the Compound Optimization view, do the following:

a. In the Optimization Mass table, type 508.208 for polytyrosine to specify a tune value 
of m/z 508.208. Alternatively, enter the m/z value for the ion of interest in your 
tuning solution.

b. Click Apply. Then, click Start. 

6. Examine the Tune Master window while automatic tuning is in progress.

Voltages for the ion transfer tube, the tube lens offset, ion lenses, and multipoles are 
automatically optimized.

7. Choose File > Save As to display the Save As dialog box, and save the values of the 
optimized parameters in a Tune Method.

The Tune Method is now optimized in NSI/MS mode using a standard tuning solution. You 
can open the Tune Method and use it as a starting point for optimizing the mass spectrometer 
using a different analyte of interest or for acquiring data.

Tuning a TSQ Series Mass Spectrometer in the Dynamic NSI Mode
This section describes the operation of the Thermo Scientific NSI source in the dynamic NSI 
mode on a TSQ Series mass spectrometer using the Tune Master (or EZ Tune) application 
program.

To perform a tuning experiment, you must connect the syringe pump on the front of your 
mass spectrometer to your dynamic NSI probe or your packed-tip NSI probe.

Table 11 displays method parameters for operation on the TSQ Quantum family of mass 
spectrometers and Table 12 displays method parameters for operation on the TSQ Vantage 
mass spectrometer. As you progress to smaller ID columns (micro-capillary to nano-capillary), 
the suggested flow rate, emitter tip ID, and capillary temperature decrease.

Note  This Tune Method is specific to the NSI mode. It is not optimized for standard 
electrospray.

Note  Thermo Fisher Scientific has discontinued the NSI-2 dynamic nanospray and 
packed-tip probes. For information about installing the NSI-1 dynamic nanospray probe, 
refer to the Dynamic Nanospray Probe (NSI-1) Installation Guide.

IMPORTANT      If you are transferring a nanospray method developed on a TSQ 
Quantum mass spectrometer to a TSQ Vantage mass spectrometer, raise the capillary 
temperature (for the ion transfer tube heater) by 50 °C. The minimum capillary 
temperature for the TSQ Vantage mass spectrometer in the NSI mode is 250 °C.
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To tune your TSQ Series mass spectrometer in the dynamic NSI mode, follow these 
procedures:

1. Connecting the Syringe Pump to the Dynamic or Packed-Tip NSI Probe

2. Setting Up the Mass Spectrometer for Dynamic NSI/MS Operation

3. Initiating Dynamic Nanospray

4. Determining the Threshold and Operational Spray Voltages

5. Optimizing the Emitter Position for Dynamic Nanospray

6. Optimizing the Ion Transport Voltage Settings for Dynamic Nanospray

IMPORTANT      When you are developing a nanospray method for the TSQ Vantage mass 
spectrometer, use a minimum capillary temperature of 250 °C. Setting the capillary 
temperature below 250 °C could result in contamination of the ion source interface and 
more frequent maintenance of the ion transfer tube.

Note  The values listed in Table 11 and Table 12 can vary significantly from emitter to 
emitter. Refer to these values as guidelines, not specifications. 

The tip ID sizes are based on PicoTips information provided by New Objective, Inc., 
Cambridge, Massachusetts. See New Objective’s Web site (http://www.newobjective.com)
or catalogs for more product information on the various tip sizes and types.

The emitter position refers to the distance of the emitter tip from the surface of the ion 
transfer tube.

Table 11. LC/NSI/MS parameters for the TSQ Quantum family of mass spectrometers

Column Size Flow Rate Tip ID Emitter Position Capillary Temperature

50 μm <100 to 300 nL/min 5 to 15 μm approx. 1 mm 225 to 275 °C

75 μm 150 to 800 nL/min 10 to 20 μm 1 to 2 mm 225 to 275 °C

180 μm 0.3 to 1.0 μL/min 20 to 30 μm 2 to 3 mm 225 to 275 °C

320 μm 1 to 5 μL/min 30 to 75 μm 3 to 5 mm 225 to 300 °C

Table 12. LC/NSI/MS Parameters for the TSQ Vantage mass spectrometer

Column Size Flow Rate Tip ID Emitter Position Capillary Temperature

50 μm <100 to 300 nL/min 5 to 15 μm approx. 1 mm 250 to 325 °C

75 μm 150 to 800 nL/min 10 to 20 μm 1 to 2 mm 250 to 325 °C

180 μm 0.3 to 1.0 μL/min 20 to 30 μm 2 to 3 mm 250 to 325 °C

320 μm 1 to 5 μL/min 30 to 75 μm 3 to 5 mm 250 to 350 °C
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Connecting the Syringe Pump to the Dynamic or Packed-Tip NSI Probe

The syringe pump on the front of the TSQ Series mass spectrometer is the sample 
introduction device that you use for the tuning procedure. The syringe pump allows you to 
infuse the tuning solution directly into the NSI source for extended periods.

The plumbing connections for NSI/MS sample introduction from the syringe pump are 
shown in Figure 81.

Figure 81. NSI/MS plumbing connections for direct infusion

Setting Up the Mass Spectrometer for Dynamic NSI/MS Operation

To set up the TSQ Series mass spectrometer for dynamic nanospray from the Tune 
window

1. Open the Tune Master window or the Thermo TSQ EZ Tune – EZ Workspace (see 
step 1 on page 102. 

2. From the Control/Scan Mode toolbar, click the On/Standby button to turn on the mass 
spectrometer.

3. Choose Setup > Change Ion Source > NSI.

On Standby Off
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4. From the Control/Scan Mode toolbar, click the Optimize Compound Dependent 
Devices button to open the Optimize Compound Dependent Devices view. Or, choose 
Display > Compound Dependent Devices. See Figure 79 on page 103. 

5. In the Optimize Compound Dependent Devices view, do the following:

a. Set auxiliary and sheath gas values to 0 units since neither are used with dynamic 
nanospray.

b. Set the spray voltage to (±)1.0 kV.

c. Enter an appropriate value for the capillary temperature. 

See Table 11 or Table 12 for the appropriate capillary temperature for your 
application.

6. On the Control/Scan Mode toolbar, click the Define Scan button to open the Define 
Scan view.

7. Set the Scan Type to Full Scan, with a mass range of about 150 to 1500. 

8. Click Apply.

9. If necessary, click the Centroid/Profile button in the Control/Scan Mode toolbar to 
toggle the data type to centroid. (The correct state of the button is shown on the left.)

10. Ensure that the polarity is set to the appropriate mode for your tuning compound. If 
necessary, click the Positive/Negative Polarity button in the Control/Scan Mode toolbar 
to toggle the ion polarity mode.

IMPORTANT      If you are transferring a nanospray method developed on a 
TSQ Quantum mass spectrometer to a TSQ Vantage mass spectrometer, raise 
the capillary temperature (for the ion transfer tube heater) by 50 °C. The 
minimum capillary temperature for the TSQ Vantage mass spectrometer in the 
NSI mode is 250 °C.
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Initiating Dynamic Nanospray 

To initiate dynamic nanospray from the Tune Master (or EZ Tune) window

1. In the Tune Master (or EZ Tune) window, choose Setup > Syringe Pump and Sample 
Loop to display the Syringe Pump dialog box. See Figure 82.

Figure 82. Syringe Pump dialog box

2. In the Syringe Flow Control group box, select the On option button to enable the 
Flow Rate spin box. Then, set the syringe pump flow rate to 1 μL/min by typing 1 in 
the Flow Rate combo box.

3. In the Syringe Type group box, select the Other option button. 

4. In the Syringe Size group box, select 1.031 mm for the syringe ID.

This is the diameter of the 50 μL syringe (P/N 00301-19014) that is used in the infusion 
experiment.

5. Click Apply to apply the parameters and start the syringe pump.

6. From the imaging system, monitor the emitter tip for the appearance of the spray. It will 
take several minutes for the test solution to fill the system.

7. Ensure that the emitter tip is 2 to 5 mm from the ion transfer tube of the mass 
spectrometer. If the emitter tip is not displayed on the imaging screen, it is too far away. 

8. Choose Display > Instrument Status to display the Instrument Status view. Then, click 
the Ion Source tab and verify that the spray voltage is (±)1.0 kV. 
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Determining the Threshold and Operational Spray Voltages

To determine the threshold spray voltage and the operational spray voltage for your 
dynamic NSI application

1. In the Tune Master (or EZ Tune) window, display the Spectrum view by clicking the 
Spectrum view button on the File/Display toolbar. 

2. Observe the test solution mass spectrum; if you are using polytyrosine as the test solution, 
the peak of interest will be at m/z 508.208.

3. From the Compound Dependent Devices view, increase the spray voltage gradually in 
50 V (0.05 kV) increments. When you observe the ion signal at m/z 508.208 (or the m/z 
appropriate for your tuning compound) in the full scan MS mode, record the voltage 
setting as the threshold voltage. The threshold voltage setting for initiating spray varies 
from (±)1.0 to 2.0 kV and depends, in part, on the syringe pump speed.

4. Increase the spray voltage setting to 100 to 200 V above the threshold value to ensure 
stability of the nanospray. This nanospray value typically falls between (±)1.2 to 2.2 kV.

5. If no signal is noted and the voltage has been raised beyond (±)2.2 kV, turn off the voltage 
and check emitter tip for droplets. 

If none are present, a clogged tip is likely. For more information, refer to 
“Troubleshooting Dynamic Nanospray” on page 118.

Optimizing the Emitter Position for Dynamic Nanospray 

You can optimize the emitter position for dynamic nanospray while monitoring the signal 
intensity of the ion of interest using the Spectrum view in the Tune Master (or EZ Tune) 
window.

To set the emitter position 

1. On the Control/Scan Mode toolbar, click the Instrument Method Development 
Workspace button to display the Instrument Method Development workspace.

2. In the Scan Parameters group box, in the Scan Range group box, select the Entry Mode: 
Center Mass option button.

IMPORTANT      Voltages above (±)2.5 kV can cause arcing between the emitter tip 
and the ion transfer tube surface.

Tip  For dynamic LC-NSI-MS experiments, the threshold voltage depends on both 
the column flow rate and the mobile phase composition. The threshold spray voltage 
value increases as the surface tension of the mobile phase and the column flow rate 
increase. The surface tension of MeOH, ACN, and Water are 0.0226 N/m, 
0.030 N/m, and 0.073 N/m, respectively.
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3. In the Center Mass combo box, type 508.208 for polytyrosine to specify a tune value of 
m/z 508.208. Alternatively, enter the m/z value for the ion of interest in your tuning 
solution.

4. Click Apply.

5. On the File/Display toolbar, click the Display TIC button to monitor the intensity of the 
ion of interest using the TIC view.

6. Turn slightly the X and Y adjustment knobs on the XYZ stage to fractionally adjust the 
tip position for signal optimization, if necessary.

Optimizing the Ion Transport Voltage Settings for Dynamic Nanospray 

You can optimize the voltage settings for the ion transport elements while monitoring the 
signal intensity of the ion of interest.

To optimize the voltage settings for the ion transport elements

1. On the Control/Scan Mode toolbar in the Tune window, click the Compound 
Optimization Workspace button to switch to the Compound Optimization workspace.

2. Select the Optimization Options: Custom options button.

3. In the Optimization Mass table, type 508.208 for polytyrosine to specify a tune value of 
m/z 508.208. Alternatively, enter the mass-to-charge ratio for the ion of interest in your 
tuning solution.

4. In the Optimize Compound Dependent Devices view, select all of the check boxes 
corresponding to optimizable items.

5. Click Start. Examine the Tune Master (or EZ Tune) window while automatic tuning is in 
progress. Voltages for the ion transfer tube, the tube lens offset, ion lenses, and multipoles 
will be automatically optimized.

6. Choose File > Save As and save the values of the optimized parameters in a Tune Method.

The Tune Method is now optimized in the NSI/MS mode. It can be recalled and used as a 
starting point for NSI/MS detector optimization either for a different analyte or for loop 
injections.

Note  The Tune Method created by performing this procedure is specific to dynamic 
nanospray with the particular operating conditions that were used. It is not optimized 
for standard electrospray.
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Maintaining and Troubleshooting Your NSI/MS 
System

This chapter contains information on maintaining and troubleshooting your LC/NSI/MS 
system.

Maintaining a scrupulously clean NSI/MS system is critical to your success at running the 
mass spectrometer in the NSI mode. After all calibrating and tuning procedures, you must 
scrupulously clean the ion source, transfer lines, and syringes. During operation of the NSI 
probe, you must avoid leaks inside the probe, which can lead to improper grounding and an 
unstable nanospray. 

In addition to requiring scrupulous cleaning, all three NSI probes contain parts that require 
frequent replacement. It is a good practice to remove the NSI source from the mass 
spectrometer before you uninstall the NSI probe to replace the emitter or PicoFrit column. 
This practice helps you to avoid damaging the tip of the new emitter or PicoFrit column as 
you reinstall the NSI probe into the base mount of the NSI source.

Cleaning the Components of the NSI/MS System
After all calibrating and tuning procedures, you must scrupulously clean the ion source, 
transfer lines, and syringes. Alternatively, you can dedicate the additional fittings provided 
(tubing and syringe) for tuning/calibration. Dedicating specific fittings, tubing, and syringes 
to tuning and calibration allows you to avoid extensive cleaning of the actual working 
apparatus.

Contents

• Cleaning the Components of the NSI/MS System

• Uninstalling the NSI Source and the NSI Probe

• Replacing the PEEKsil Tubing of the Packed-Tip NSI Probe

• Troubleshooting

Note  For best results, set aside a dedicated set of labware (syringe, fittings, and tubing) for 
the sole purpose of calibrating the instrument. This will help you to avoid cross 
contamination.
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Cleaning after calibration entails successive washings with acetone, isopropyl alcohol, and 
methanol in that order. These agents are pumped through all transfer lines and emitters with 
the syringe pump. You must also clean the spray shield and the exterior of the ion tube with 
successive solvent washes. After you have performed the above cleaning procedures, using a 
spray bottle or syringe/filter, successively spray the solvents listed above into the ion transfer 
tube and scour with the reaming bar after each solvent spray.

If you can still detect very small levels of residual calibration compound after following the 
cleaning steps described above, then proceed with a more thorough cleaning of the API stack 
components. Successively clean the stack with acetone, isopropyl alcohol, and methanol. For 
more information on how to clean API source components, refer to the appropriate hardware 
manual.

Uninstalling the NSI Source and the NSI Probe
It is a good practice to uninstall the NSI source before you attempt to replace an emitter or 
PicoFrit column.

To uninstall the NSI source and dismount the NSI probe

1. Before you uninstall the NSI probe, ensure that you have a clean worksite where you can 
handle your micro fluidic connections.

2. Open the Tune Master (or EZ Tune) or Tune Plus window and choose Control > 
Standby to put the mass spectrometer in Standby mode. If you are running the LC 
pump, turn off its flow.

3. Remove the high voltage cable between the NSI base mount and the NSI extension 
assembly by turning the locking ring on the power cable counterclockwise. Then, gently 
pull the high voltage connector out of the receptacle on the NSI base mount.

4. Depending on your NSI probe configuration, disconnect the liquid transfer line, gas line, 
or syringe line from the rear of the NSI probe.

CAUTION  Always wear protective gloves and safety glasses when you use solvents or 
corrosives. Also, contain waste streams and use proper ventilation. Refer to your supplier’s 
Material Safety Data Sheet (MSDS) for proper handling of the particular solvent.

CAUTION  AVOID BURNS. Some of the API stack components, such as the spray cone and 
ion transfer tube, can reach temperatures of 350 °C. Always allow the API components to 
cool down from operating temperature to room temperature before cleaning the 
components.

CAUTION  AVOID ELECTRICAL SHOCK. Make certain that all electrical voltages are at 
ground potential before handling the NSI source
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5. Loosen the flange retainer bolts and remove the NSI source from the NSI extension 
assembly.

6. Disconnect the high voltage lead of the NSI probe from the base mount. Then, slide the 
NSI probe backwards out of the NSI base mount.

7. Place the NSI probe on a lint free cloth in the area that you have reserved as your micro 
fluidic worksite.

Replacing the PEEKsil Tubing of the Packed-Tip NSI Probe
Occasionally the PEEKsil tubing portion of the liquid junction for the packed-tip NSI probe 
becomes clogged. 

To replace the PEEKsil tubing

1. Put your LC/NSI/MS system in the Standby mode and ensure that the solvent flow from 
the LC pump is Off. 

2. Detach the packed-tip NSI probe from the LC pump by unscrewing, and then removing 
the short head nut.

3. Detach the NSI source from the mass spectrometer.

4. Detach the packed-tip NSI probe from the NSI source.

5. Remove the clogged PEEKsil tubing as follows:

a. Pull the probe cover off the probe body.

b. Pull the liquid junction out of the spring retainer.

c. Unscrew and remove the fingertight fitting.

d. Using two 3/16 in. wrenches, unscrew the tube nuts from the ground junction and 
the voltage junction. See Figure 83.
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Figure 83. Liquid junction of packed-tip nanospray probe

e. Discard the clogged PEEKsil tubing.

6. Reassemble the liquid junction as follows:

a. Slide the tube nuts onto a new piece of PEEKsil tubing.

b. Screw one tube nut into the ground junction and tighten the connection with a 
3/16 in. wrench.

c. Screw the other tube nut into the voltage junction and tighten the connection with a 
3/16 in. wrench.

d. Reattach the fingertight fitting and the PicoFrit column to the voltage junction.

7. Reinsert the liquid junction into the spring retainer.

8. Reattach the probe cover to the probe body.

Troubleshooting
This section provides troubleshooting tips for the problems you might encounter while 
running your NSI/MS system and contains the following topics:

• Troubleshooting Static Nanospray

• Troubleshooting Dynamic Nanospray

• Troubleshooting Microscale LC/MS

IMPORTANT  It is critical that you avoid leaks surrounding the liquid junction of 
your NSI probe. If the exterior of the liquid junction becomes wetted, improper 
grounding occurs, leading to anomalously high and unstable spray currents.

PicoFrit column

Standard nut (blue)

Tube nuts

PEEKsil 
tubing

Voltage junction

Ground junction
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Troubleshooting Static Nanospray 

Use the guidelines listed in Table 13 for troubleshooting static nanospray problems.

Table 13. Common static nanospray problems, their causes, and solutions

Problem Possible Causes Solution

No stable background ion 
signals are observed in full 
scan MS mode when the 
high voltage is set above 
(±)2 kV and the emitter is 
positioned approximately 
2 mm from the ion transfer 
tube and is centered.

Most likely the electrical 
contact is discontinuous 
and the electrospray voltage 
is not being applied to the 
emitter.

Check: 

• HV connection at the high voltage leads beneath the 
probe cover

• HV connection between NSI probe and mass 
spectrometer

• the integrity of the emitter coating

• contact between the coated tip and the contact clip to 
ensure electrical continuity

Analyte ion signal is 
observed only for a very 
short period of time, less 
than 2 to 5 minutes.

• No sample solution

• air bubbles

• emitter tip broken

• backpressure is too 
high 

Remove the emitter and check if any sample solution 
remains.

A) If some sample solution remains in the capillary, the 
flow disruption is most likely due to air bubbles 
trapped inside the tip during sample loading. Reload 
the sample carefully following instructions provided 
in Chapter 4

B) If the entire sample is gone:

• The emitter tip might be partially broken, resulting 
in a high flow rate. Change the emitter and reload the 
sample

• The backpressure provided to initiate the flow is too 
high and the sample was ejected. Reload the sample 
into the tip and reduce the speed of, or turn off the 
syringe used for initiating the flow. 

Analyte ion signal is not 
observed or is very weak. 
Some low mass background 
ions (for example m/z 371 
and 445) are observed, but 
no high mass background 
ions are observed.

The spray conditions are 
not optimized, and either:

• the flow rate is too low

• the emitter is clogged

If increasing the spray voltage in 100 V increments does 
not solve the problem, increase the syringe pump speed, 
or turn the syringe pump on for 5 to 10 s to further push 
the liquid through the tip.

If the symptom persists when the nanospray voltage is 
above (±)2 kV and the gas backpressure is above 50 units, 
remove the emitter and check the sample solution inside. 
If there is significant sample solution left in the capillary, 
the emitter tip is most likely clogged. Change the emitter 
and reload with clean sample. 
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Troubleshooting Dynamic Nanospray 

Use the guidelines in the following table for troubleshooting dynamic nanospray problems.

Table 14. Common problems in dynamic nanospray, their possible cause, and solution(s)

Problem Possible Cause Solution

No stable background ion 
signals are observed in full 
scan MS mode when the 
high voltage is set above 
(±)2 kV and the emitter is 
positioned approximately 
2 mm from the ion transfer 
tube and is centered

Most likely the electrical 
contact is discontinuous 
and the electrospray voltage 
is not being applied to the 
emitter.

Check:

• high voltage connection

• emitter coating to ensure electrical continuity

• proper connection of high voltage pin leads, properly 
configured for liquid junction or tip

• the emitter under a microscope and look for 
fractures. Replace the emitter if necessary

Analyte ion signal was 
observed intermittently

Most likely the spray is 
unstable due to either:

• too low voltage

• air bubbles in the line

Use the camera and monitor to observe the surface of the 
ion transfer tube. Use the X or Y adjustment knobs to 
move the emitter slightly off axis. If liquid does not 
continuously appear on the ion transfer tube, increase the 
spray voltage slowly. If a stable spray does not occur and 
the voltage is increased over the recommended value, turn 
off the voltage and check the emitter.

If solvent appears to be flowing at the desired flow rate, 
the flow might have been disrupted due to air bubbles in 
the line. Degas the solvent to remove air and equilibrate 
your sample to room temperature to avoid outgassing of 
the solvent. 

Analyte ion signal is not 
observed or is very weak. 
Some low mass background 
ions (for example m/z 371 
and 445) are observed, but 
no high mass background 
ions.

The spray conditions are 
not optimized, and either:

• the flow rate might be 
too low

• the voltage might be 
too high

Turn off the voltage and check the emitter. If solvent does 
not appear to be flowing at the desired flow rate, the 
emitter might be clogged. Change the emitter, if 
necessary, and reload with clean sample that has been 
centrifuged. 

If the solvent flow rate appears to be too low, drop the 
voltage to (±) 0.9 kV and increase it in 50 V increments 
until spraying commences.

Anomalously high and 
unstable spray currents

If the exterior of the liquid 
junction becomes wetted, 
improper grounding 
occurs.

Avoid leaks surrounding the liquid junction of your NSI 
probe. 
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Troubleshooting
Troubleshooting Microscale LC/MS

Use the guidelines in Table 15 for troubleshooting problems with microscale LC/MS.

Table 15. Common problems in microscale LC/MS, their possible cause, and solution(s)

Problem Possible Cause Solution(s)

The flow rate seems to 
change over the course 
of the last several 
experiments.

It is likely that the 
column starts to foul and 
the split ratio is changed 
as a result of the 
increased back pressure 
of the column.

1. Adjust column flow rate.

2. Clean or replace column.

Flow rate is not low 
enough for optimum 
column performance, 
but it is impossible to 
lower the pump flow rate 
even more.

The split ratio of the 
LC-tee splitter might be 
incorrect.

Increase the split ratio by shortening the restrictor line.

The loop injection signal 
is very weak and spread 
out in time.

A large dead volume 
exists in the plumbing 
between the HPLC and 
the emitter.

Check all of the connections and ensure only ZDV 
unions are installed. Refer to Chapter 2 for guidelines on 
microfluidic plumbing.

A large droplet of solvent 
forms at the tip and 
requires spray voltage 
settings above the 
recommended range to 
break up.

Spray hysteresis caused 
by large surface tension 
of the solvent

Spray instability caused 
by fracture to emitter tip

Carefully add a drop of organic solvent, for example, 
acetonitrile or methanol to the tip with a plastic pipette to 
overcome the large surface tension of the droplet.

Replace the PicoTip or PicoFrit emitter/column.
Thermo Scientific Nanospray Ion Source User Guide 119





12
Replaceable Parts

This chapter lists replaceable and consumable parts and part numbers for the Thermo 
Scientific NSI source. To ensure proper results in servicing the Thermo Scientific NSI source, 
order only the parts listed. 

Thermo Scientific Consumable Parts
You can order these parts from Thermo Fisher Scientific: 

Fused silica, 50 μm ID, 360 μm OD, 5 meter lengths. . . . . . . . . . . . . . . . . . . 00106-10512
HPLC column, 180 μm ID, 150 mm length, C8 . . . . . . . . . . . . . . . . . . . . . . 00109-00504
HPLC column, 320 μm ID, 150 mm length, C18 . . . . . . . . . . . . . . . . . . . . . 00109-00505
Syringe, 50 μL, removable needle, gas tight . . . . . . . . . . . . . . . . . . . . . . . . . . . 00301-19017
Teflon tubing, 15 cm, 1/16 in. 0.007 in. ID × 0.063 in. OD  . . . . . . . . . . . . . 00301-22803
Teflon tubing, 0.5 cm, 1/16 in. 0.003 in. ID × 0.063 in. OD . . . . . . . . . . . . . 00301-22915
Polytyrosine – 1,3,6 Calibration Solution (liquid) . . . . . . . . . . . . . . . . . . . . . . 00301-22924
Polytyrosine – 1,3,6 Calibration Solution (solid) . . . . . . . . . . . . . . . . . . . . . . . 00301-22925
Chemical; MS standards . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 97000-62042
Adapter ring, 1 in. for dynamic probes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 97055-20415
Adapter ring, 2 in. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 97144-60270
O-ring, 0.125 in. ID × 1/16 in OD, Viton . . . . . . . . . . . . . . . . . . . . . . . . . . . 00107-02550
O-ring, 0.176 in. ID × 1/16 in OD, AS-008, Viton . . . . . . . . . . . . . . . . . . . . 00107-02575

Note  Thermo Fisher Scientific has discontinued the NSI-2dynamic nanospray and 
packed-tip probes. For information about ordering and installing the original dynamic 
nanospray probe, refer to the Dynamic Nanospray Probe (NSI-1) Installation Guide.

Contents

• Thermo Scientific Consumable Parts 

• Thermo Scientific Kits

• Upchurch Scientific Parts

• New Objective, Inc. Parts
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Thermo Scientific Kits
Thermo Scientific Kits
You can order these kits from Thermo Fisher Scientific:

Nanospray Interface Ion MAX Kit 
(for systems w/ an Ion MAX source . . . . . . . . . . . . . . . . . . . . . . . . . . OPTON-20050
Nanospray documentation CD. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 97055-64041
Ion MAX adapter . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . N/A
Assembly, adapter flange for Ion MAX, nanospray . . . . . . . . . . . . . . . . . . . . . . . . . N/A
Nanospray, flange, extension (1 in. adapter ring)  . . . . . . . . . . . . . . . . . . . . . . . . . . N/A
Nanospray, translation flange  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . N/A
Nanospray, base, Upchurch. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . N/A

NSI-2, source mount kit for LCQ Deca XP and LCQ Advantage XP . . . OPTON-20055
Nanospray documentation CD. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 97055-64041
Nanospray, translation flange  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . N/A
Nanospray, flange extension (1-in. deep adapter ring) . . . . . . . . . . . . . . . . . . . . . . . N/A
Adapter ring, 2 in. deep  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . N/A
Nanospray, base, Upchurch. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . N/A
Kit, video, nanospray, 230V, w/o display  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . N/A

NSI-2, source mount upgrade kit 
(for LCQ Deca XP and LCQ Advantage XP  . . . . . . . . . . . . . . . . . . . OPTON-20054
Nanospray documentation CD. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 97055-64041
Nanospray, base, Upchurch. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . N/A
Nanospray, flange extension (1-in. adapter ring) . . . . . . . . . . . . . . . . . . . . . . . . . . . N/A

Static probe and accessory kit . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . OPTON-20051
Dynamic probe, accessory kit, and column support  . . . . . . . . . . . . . . . . . . Discontinued
Packed-Tip probe and accessory kit . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Discontinued
Kit, Dynamic Probe accessory  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 97055-98033

Adapter nut  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . N/A
Ferrule, high pressure, FingerTight II, 10 pack . . . . . . . . . . . . . . . . . . . . . . . . . . . . N/A
Female nut . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . N/A
Front nut, conductive . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . N/A
MicroFerrule for 1/16 in. OD tubing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . N/A
MicroFerrule, 0.025 in., black  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . N/A
MicroTight sleeve, green, PEEK . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . N/A
Tube, PEEKsil, 1/16-in. × 50 μm 8 cm, 2 each. . . . . . . . . . . . . . . . . . . . . . . . . . . . N/A
Union, ZDV, stainless steel, 2 each . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . N/A

Kit, Static Probe accessory  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 97055-98039
Glass, PicoTip, 10 each. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . N/A
Contact, PicoTip  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . N/A
O-ring, 0.125 in. ID × 1/16 in OD, Viton. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . N/A
O-ring, 0.176 in. ID × 1/16 in OD, Viton. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . N/A

Kit, Packed-Tip Probe accessory. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 97055-98040
Union, conductive, sym, (2 each) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . N/A
Union, conductive, inlet, (2 each). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . N/A
Tube, connector, PEEKsil, (5 each). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . N/A
Fitting, (2 each)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . N/A
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Upchurch Scientific Parts
Ferrule, for 1/32 in. tubing, (5 each). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . N/A
Ferrule, for 1/16 in. tubing, (5 each). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . N/A
PicoFrit columns, (2 pack) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . N/A
Fingertight fitting, (10 each). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . N/A

Upchurch Scientific Parts
You can order the these parts from Upchurch Scientific:

Dynamic Probe Assembly . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . S-2498-1
Kit, Dynamic Probe accessory  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . S-2498-2

PEEKsil Tubing, 1/16 in. × 50 μm x 8 cm . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6508-1
MicroFerrule, PEEK, Fingertight, 1/16-in. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-132
Ferrule, PEEK, Fingertight, 1/16-in.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-142
MicroFerrule, 0.025 in., PEEK, black. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-172
MicroTight Sleeve, green, PEEK, 0.015 in. ID × 0.025 in. OD . . . . . . . . . . . . . . F-185
Female nut . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . P-416
Front nut, conductive . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .S-2494-21
Adapter nut  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .S-2494-16
ZDV union, 0.010 in. ID, stainless steel. . . . . . . . . . . . . . . . . . . . . . . . . . . . . U-435-01

New Objective, Inc. Parts
You can order these parts from New Objective, Inc.:

Pre-cut, 5 cm length, 30 μm ID tip, PicoTip emitter. . . . . . . . . . . . F360 - 50 - 30 - N - CT
Pre-cut, 5 cm length, 10 μm ID tip, PicoTip emitter. . . . . . . . . . . . F360 - 25 - 10 - N - CT
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A

Supplier Information

This appendix provides a partial list of lab equipment and chemical supply companies for 
your reference. To order nanoscale fittings and tubing, contact Upchurch Scientific. To order 
PicoTip emitters, SilicaTip emitters, and PicoFrit columns, contact New Objective, Inc.

Upchurch Scientific

619 Oak St.,
Oak Harbor, WA 98277

Phone: (800) 426-0191 or (360) 679-2528
Fax: (800) 359-3460 or (360) 679-3830
E-mail: upchurch@upchurch.com
Web address: http://www.upchurch.com

New Objective, Inc.

2 Constitution Way
Woburn, MA 01801-1023 USA

Phone: (888) 220-2998 or (781) 933-9560
Fax: (781) 933-9564
E-mail: sales@newobjective.com
Web address: http://www.newobjective.com

VWR International

300 Hadley Rd.
So. Plainfield, NJ 07080

Phone: (800) 932-5000 or 908-757-4045
Fax: (908) 757-0313
Web address: http://www.vwrsp.com
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A Supplier Information
Fisher Scientific (US Headquarters)

2000 Park Lane Dr.
Pittsburgh, PA 15275-9943

Phone: (800) 766-7600 or 412-490-8300
Fax: (800) 926-1166
Web address: http://www.fishersci.com

Brinkman Instrument Inc.

One Cantiague Rd. 
Westbury, NY 11590-0207

Phone: (800) 645-3050 or 516-334-7500
Fax: (516) 334-7506
E-mail: info@brinkmann.com
Web address: http://www.brinkmann.com
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B

Installing the Osprey MultiMedia Capture Device, 
Software, and Drivers

This Appendix provides detailed, step-by-step procedures for installing the video capture card 
and the associated driver for the video capture system. 

Installing the Video Capture Card
To install the video capture card

1. Shut off the system computer. 

2. Remove the cover from the computer. 

3. Locate an available PCI slot to install the card, and remove the PCI slot dust cover. 

4. Install the video capture card into the PCI slot. 

5. Replace the cover on the computer. 

6. Turn On the computer and log onto the operating system. Note, the computer detects 
the new hardware upon startup. See Figure 84. 

Figure 84. Found New Hardware message 

7. Cancel the Found New Hardware wizard, which starts automatically, by clicking Cancel. 
See Figure 85. 

Contents

• Installing the Video Capture Card

• Installing the Device Driver

• Testing the Osprey MultiMedia Capture Application
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Installing the Video Capture Card
Figure 85. Found New Hardware Wizard – Welcome page

The drivers for the video capture card need to be installed before the video can be used. Go to 
the next section, “Installing the Device Driver.” 
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 B Installing the Osprey MultiMedia Capture Device, Software, and Drivers
Installing the Device Driver
Installing the Device Driver
To install the Osprey device driver with the Osprey driver installation wizard

1. Insert the Osprey Software Installation CD into the CD drive. The Osprey Software 
Installation program starts automatically. See Figure 86. 

Figure 86. Osprey Software Installation page showing Welcome screen

2. In the navigation bar on the left, click Driver Installation to expand the list of Microsoft 
operating systems supported by the Osprey video capture system. See Figure 87.

Figure 87. Osprey Software Installation page with list of supported operating systems
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Installing the Device Driver
3. From the Driver Installation list, select Windows XP to begin downloading the Osprey 
MultiMedia Capture 2.2.2 Windows XP driver installation application. See Figure 88. 

Figure 88. File Download dialog box

4. In the File Download dialog box, click Open to begin downloading the Osprey 
MultiMedia Capture 2.2.2 Windows XP driver installation application to a temporary 
folder. See Figure 89.

Figure 89. Installation Folder dialog box (for Windows XP)
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 B Installing the Osprey MultiMedia Capture Device, Software, and Drivers
Installing the Device Driver
5. From the Osprey MultiMedia Capture 2.2.2 Windows XP driver installation application 
– Installation Folder dialog box, click Continue to download the Osprey MultiMedia 
Capture 2.2.2 Windows XP driver installation application to a temporary folder. See 
Figure 90.

Figure 90. Folder Creation dialog box

6. From the Osprey MultiMedia Capture 2.2.2 Windows XP driver installation application 
– Folder Creation dialog box, click Yes to create a temporary folder and to begin 
unpacking the application. See Figure 91.

Figure 91. Application Unpacking status box
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Installing the Device Driver
7. After the Osprey MultiMedia Capture 2.2.2 Windows XP driver installation application 
is unpacked, the Osprey MultiMedia Capture Setup wizard is displayed. See Figure 92.

Figure 92. Osprey MultiMedia Capture Setup wizard – Introduction dialog box
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 B Installing the Osprey MultiMedia Capture Device, Software, and Drivers
Installing the Device Driver
8. In the Osprey MultiMedia Capture Setup wizard, click Next to display the Information 
dialog box. See Figure 93. 

The information dialog box indicates the types of cards and operating systems that the 
Osprey drivers are designed to operate with.

Figure 93. Osprey MultiMedia Capture Setup wizard – Information dialog box
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B Installing the Osprey MultiMedia Capture Device, Software, and Drivers
Installing the Device Driver
9. Click Next to display the software license agreement. See Figure 94. 

Read the end user license agreement. 

Figure 94. Osprey MultiMedia Capture Setup wizard – Software License Agreement dialog 
box
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Installing the Device Driver
10. Click Yes. The Setup Type dialog box is displayed. See Figure 95. 

Figure 95. Osprey MultiMedia Capture Setup wizard – Setup Type dialog box
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B Installing the Osprey MultiMedia Capture Device, Software, and Drivers
Installing the Device Driver
11. Ensure that the NTSC option button is selected. Click Next to display the Choose 
(driver) Destination Location dialog box. See Figure 96. 

The wizard shows the default location where the driver will be installed. 

Figure 96. Osprey MultiMedia Capture Setup wizard – Choose Destination Location dialog 
box
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 B Installing the Osprey MultiMedia Capture Device, Software, and Drivers
Installing the Device Driver
12. Click Next to install the driver in the default location and to display the Select Program 
Folder dialog box. See Figure 97. 

The wizard indicates the program folder in which it will place the application shortcuts. 

Figure 97. Osprey MultiMedia Capture Setup wizard – Select Program Folder dialog box
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B Installing the Osprey MultiMedia Capture Device, Software, and Drivers
Installing the Device Driver
13. Click Next to continue. The Start Copying Files dialog box is displayed. See Figure 98.

Figure 98. Osprey MultiMedia Capture Setup wizard – Start Copying Files dialog box
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 B Installing the Osprey MultiMedia Capture Device, Software, and Drivers
Installing the Device Driver
14. Click Next to continue. An informational dialog box about codec 
(compression/decompression) software is displayed. See Figure 99. 

Figure 99. Osprey MultiMedia Capture Setup wizard – Information dialog box
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Installing the Device Driver
15. Click Next to continue. The Setup Status dialog box is displayed. See Figure 100. 

The wizard copies the driver files onto the computer hard drive, which might take a 
couple of minutes.

Figure 100. Osprey MultiMedia Capture Setup wizard – Setup Status dialog box

16. When the wizard finishes copying files to the hard drive, a dialog box is displayed that 
gives you the option to install an additional shortcut on the desktop. See Figure 101. This 
shortcut is not necessary; therefore, click No. 

Figure 101. Osprey MultiMedia Capture Setup wizard – ViewCast Corporation / Osprey Video 
Division Special Offers Shortcut dialog box
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 B Installing the Osprey MultiMedia Capture Device, Software, and Drivers
Installing the Device Driver
17. The wizard then displays another Information dialog box describing the terms of the 
SimulStream shareware that was installed on your computer. See Figure 102. 

Figure 102. Osprey MultiMedia Capture Setup wizard – Information dialog box

18. Acknowledge the Information dialog box by clicking OK. The Product Registration 
dialog box is displayed. See Figure 103.

Figure 103. Osprey MultiMedia Capture Setup wizard – Product Registration dialog box
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Installing the Device Driver
19. In the Product Registration dialog box, choose Yes to launch the Product Registration 
HTML form. See Figure 104.

Figure 104. Product Registration HTML form

20. Complete the registration form and click Submit to register your software. 
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Testing the Osprey MultiMedia Capture Application
21. After you submit your registration, the Osprey MultiMedia Capture Setup wizard will 
display the Setup Complete dialog box (see Figure 105) remove any disk(s) from the 
computer disk drive(s) and click Finish to complete the setup and restart the computer.

Figure 105. Osprey MultiMedia Capture Setup wizard – Setup Complete dialog box

The Osprey MultiMedia Capture 2.2.2 Windows XP driver installation application has 
successfully installed the necessary software, drivers, and updates. Go to the next section, 
“Testing the Osprey MultiMedia Capture Application.” 

Testing the Osprey MultiMedia Capture Application
To restart the computer and check the video capture application

1. Connect the video camera to the video capture card using a coaxial cable. The camera also 
needs to be connected to its power supply and turned on for the image to be viewed from 
the computer. 

2. Start the Osprey MultiMedia Capture application to ensure proper operation of the video 
capture system by selecting Start > Programs > Osprey MultiMedia Capture > 
SwiftCap. See Figure 106. 
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Testing the Osprey MultiMedia Capture Application
Figure 106. Osprey Video Capture application

The installation of the Osprey MultiMedia Capture system is completed successfully if you 
can view the nanospray tip from the Osprey MultiMedia Capture application.
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C

Tuning Solutions for the NSI Mode

This appendix provides instructions for preparing the solution that is used to tune the mass 
spectrometer in the NSI mode. 

Always take safety precautions when you handle chemicals and unknown samples. READ 
AND UNDERSTAND THE HAZARDS OF THE CHEMICALS USED IN THE 
FOLLOWING PREPARATIONS. Dispose of all laboratory reagents by the appropriate 
method for a specific reagent or solvent.

Material Safety Data Sheets (MSDS) provide summarized information on the hazards and 
toxicity of specific chemical compounds. MSDSs also provide information on the proper 
handling of compounds, first aid for accidental exposure, and procedures for the remedy of 
spills or leaks. Producers and suppliers of chemical compounds are required by law to provide 
their customers with the most current health and safety information in the form of an MSDS. 
Read the MSDSs for each chemical you use. 

Examples of potentially hazardous chemicals used in procedures throughout this manual are 
as follows:

• Acetic acid

• Formic acid

• Methanol

CAUTION   AVOID EXPOSURE TO POTENTIALLY HARMFUL MATERIALS. Always wear 
protective gloves and safety glasses when you use solvents or corrosives. Also, contain 
waste streams and use proper ventilation. Refer to your supplier's Material Safety Data 
Sheet (MSDS) for the proper handling of a particular solvent.

Contents

• Tuning Solution for LCQ Series and LTQ Series Mass Spectrometers

• Tuning Solution for TSQ Series Mass Spectrometers
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Tuning Solution for LCQ Series and LTQ Series Mass Spectrometers
The recommended tuning solution for a LCQ Series or LTQ Series mass spectrometer 
configured with an NSI source is either 1 to 5 pmol/μL MFRA in 1% acetic acid 
methanol /water 50:50 or a tuning solution with a sample concentration of 1 to 5 pmol/μL.

To prepare a solution of 5 pmol/μL MFRA in 1% acetic acid methanol /water, perform the 
procedures provided in this section in the order listed:

• Preparing the MRFA Stock Solution

• Preparing the MRFA Working Solution for NSI/MS

Preparing the MRFA Stock Solution

The concentration of the MRFA stock solution is 5.0 nmol/mL MRFA in 50:50 
methanol/water.

To prepare 1 mL of the MRFA stock solution

1. Obtain the vial of L-methionyl-arginyl-phenylalanyl-alanine acetate•H2O (MRFA) in 
your API accessory kit. In this form, the MRFA sample has an average molecular weight 
of 607.7 u. Carefully weigh 2.6 mg of the MRFA sample.

2. Make up the MRFA solution to a total volume of 1.0 mL with a mixture of 50:50 
methanol / water. Mix the solution thoroughly.

3. Label the vial MRFA Stock Solution.

Preparing the MRFA Working Solution for NSI/MS

The concentration of the MRFA working solution is 5.0 pmol/μL MRFA in 1% acetic acid 
methanol / water 50:50.

To prepare 100 mL of MRFA working solution

1. Pipet 0.1 mL of the MRFA stock solution (5.0 nmol/μL) into a 100 mL volumetric flask.

2. Dilute to volume with 1% acetic acid in 50:50 methanol / water.

3. Label the flask MRFA Tuning Solution for Nanospray.

Note  Do not inject the MFRA stock solution into the mass spectrometer while it is 
configured with an NSI source.
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Tuning Solution for TSQ Series Mass Spectrometers
This section contains two procedures for preparing solutions of polytyrosine – 1, 3, 6 that are 
suitable for testing the performance of a TSQ Series mass spectrometer configured with an 
NSI source.

The first procedure describes how to reconstitute the performance test solution using the 
20-mL vial that contains pre-weighed amounts of the polytyrosine components in dry powder 
form (P/N 00301-22925). The contents of the vial is so small that it has the appearance of a 
residue. This vial is supplied in the accessory kit.

The second procedure describes how to prepare the performance test solution from your stock 
of dry chemicals.

Your accessory kit also contains a 20-mL vial of polytyrosine – 1, 3, 6 in solution 
(P/N 00301-22924). You need to dilute this solution 100-fold before you infuse it into your 
NSI/MS system.

Table 16 provides a summary of the polytyrosine standards supplied in the accessory kit.

Reconstituting the Polytyrosine – 1, 3, 6 Solution Using the Prepackaged Mixture

Polytyrosine is provides as a prepackaged mixture ((P/N 00301-22925).

To reconstitute the polytyrosine – 1, 3, 6 solution

1. Obtain the vial of premixed polytyrosine chemicals from the accessory kit.

2. Prepare a concentrated stock solution of polytyrosine as follows:

a. Add 20 mL of 0.1% formic acid in 50:50 methanol / water to the vial. Then, swirl 
the vial to dissolve the polytyrosine residue. 

This yields a solution of 4 ng/μL of Tyr, 12 ng/μL of (Tyr)3, and 24 ng/μL of (Tyr)6.

b. Label the vial Polytyrosine – 1, 3, 6 Nanospray Stock Solution.

Table 16. Polytyrosine standards supplied in the accessory kit

Standard Description
(on label)

Thermo Scientific
Part Number

C S Bio Company 
Product Number

Polytyrosine Standard
Liquid Form

00301-22924 CS0272L

Polytyrosine Standard
Solid Form

00301-22925 CS0272S

Note  Do not inject the stock solution into your mass spectrometer while it is 
configured with an NSI source.
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3. Prepare the 20 mL of working test solution as follows:

a. Dilute the stock solution 100 fold with 0.1% formic acid in 50:50 methanol / water. 

b. Label the vial Polytyrosine – 1, 3, 6 Nanospray Working Solution.

4. Store the test solutions in a refrigerator until needed.

Preparing the Polytyrosine – 1, 3, 6 Tuning Solution Your Stock of Dry Chemicals

You can prepare the polytyrosine – 1, 3, 6 tuning solution from your stock of dry chemicals.

To prepare 250 mL of the polytyrosine – 1, 3, 6 tuning and calibration solution 

1. Weigh out and deliver 1 mg of L-tyrosine, 3 mg of (Tyr)3, and 6 mg of (Tyr)6 into a 
clean, dry, 250  mL volumetric flask.

2. Add approximately 50 mL of 0.1% formic acid in 50:50 methanol / water to the 
volumetric flask. Swirl the flask to dissolve the polytyrosine mixture. Then, fill the flask to 
volume. This yields a solution containing 4 ng/μL of L-tyrosine, 12 ng/μL of (Tyr)3, and 
24 ng/μL of (Tyr)6.

3. Transfer the solution to a clean vial labeled Polytyrosine – 1, 3, 6 Tuning and Calibration 
Solution, and store it in a refrigerator until it is needed.

Table 17 summarizes the compounds used to prepare the tuning and calibration solution.

Table 17. Polytyrosine tuning and calibration stock standard summary

Compound Formula MW Vendor Vendor P/N

L-Tyrosine C9H11NO3 181.19 Sigma T8566

Tyr-Tyr-Tyr C27H29N3O7 507.54 Sigma T2007

(Tyr) 6 C54H56N6O13 997.07 Sigma T1780

Note  You can order standard chemicals directly from Thermo Scientific, San Jose, or you 
can contact these chemical suppliers:

Sigma Chemical Company
P.O. Box 14508
St. Louis, MO, USA 63178-9916
(800) 325-3010 (in the USA or Canada)
[1] (314) 771-3750 (outside the USA or Canada)

C S Bio Company
1300 Industrial Road
San Carlos, CA, USA 94070
(800) 627-2461 (in the USA or Canada)
[1] (650) 802-0880 (outside the USA or Canada)
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Index
A
adapter nut for the dynamic nanospray probe  49
adjustment screw for static emitter  45
API

spray shield  31
stack components (CAUTION)  114

assembling
CCD camera and optics  36
dynamic NSI probe  49
NSI source  58
packed-tip NSI probe  54
static NSI probe  44

B
backpressure, excessive  117
BNC cable  41
bubble formation in tubing  11

C
C S Bio Company, buying chemicals (note)  148
camera

focusing  42
mounting stand  37
movement to image behavior  42

capillary temperature
for an LCQ Series MS detector  81
for an LTQ Series MS detector  93

capillary temperatures
for an TSQ Series mass spectrometer  106

CAUTIONS
avoiding

contact with chemicals  145
wearing safety protective gear  114

Cautions
avoid leaks surrounding the liquid junction of the NSI 

probe  116
avoiding arcing to nanospray needle  77, 90, 98
avoiding contamination of system  46

centrifuging samples  46

chemicals
avoiding contact with (CAUTION)  145
C S Bio Company (note)  148
ordering (note)  148
Sigma Chemical Company (note)  148

chemicals, ordering  148
cleaning tuning apparatus and inlet of MS detector  114
clogging columns and emitters  10
collar, inside nose cone tip (figure)  45
column internal diameters  19
column support assembly  60
compliance

WEEE  v
components

extension assembly  28
imaging system  35
NSI source  58
packed-tip NSI probe  54
static NSI probe (figure)  43

connection
between dynamic NSI probe and syringe pump  71
between packed-tip probe and syringe pump  72
between static NSI probe and syringe pump  69

counter electrode  1
cutting

emitters  14
fused silica tubing  13
PicoFrit columns  18
static NSI emitter  44
tubing  13

D
dead volume, reducing  11
dedicating specific fittings for tuning  113
disintegration of liquid with ESI  1–2
disposable micropipettes, using  23
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Index: E
dynamic nanospray
adjusting emitter tip position  64
capillary temperature

for a TSQ Series MS detector  107
for an LCQ Series MS detector  81
for an LTQ Series MS detector  94

components  58
initiating

for a TSQ Series MS detector  110
for an LCQ Series MS detector  84
for an LTQ Series MS detector  96

optimizing emitter position
on a TSQ Series MS detector  111
on an LCQ Series MS detector  85
on an LTQ Series MS detector  98

setting up for operation
for a TSQ Series MS detector  108
for an LCQ Series MS detector  82
for an LTQ Series MS detector  95

spray voltage range
for a TSQ Series MS detector  111
for an LCQ Series MS detector  85
for an LTQ Series MS detector  97

troubleshooting  118

E
electric field  1, 15
electrohydrodynamic disintegration  1–2
electromagnet compatibility  iii
electrospray ionization  1
emitter position, optimizing for dynamic nanospray

on a TSQ Series MS detector  111
on an LCQ MS detector  85
on an LTQ Series MS detector  98

emitter position, optimizing for static nanospray
on a TSQ Series MS detector  105
on an LCQ Series MS detector  79
on an LTQ Series MS detector  92

emitter tip
selecting ID  15
troubleshooting position  7, 35
use  1

emitters for dynamic nanospray probe  123

F
FCC compliance  iii
filtered solvents  11
flow disturbance  11
flow rates, selecting  19
flow splitter  20
focal length of camera, adjusting  42

focusing picture, (note)  42
Found New Hardware wizard  127
front nut for the dynamic nanospray probe  51

G
gas phase ions  1
gel loading tips, recommended  46
guidelines

for preparing samples  46
for solvents  11
for using syringe pump for backpressure  104

H
high spray voltages causing arcing  79, 91, 104

I
IDs for emitter tips

for dynamic nanospray  16
for static nanospray  15

imaging system  7
adjusting  41
components  35–36

infusing a test solution
on a TSQ Series MS detector  106
on an LCQ Series MS detector  82
on an LTQ Series MS detector  95

installing
a syringe in the syringe pump  70
column support assembly  59
imaging system  35
NSI base mount  58
NSI probe  59
NSI source  57
the nanospray extension assembly  31
video capture card  39, 127
video capture system  127

L
LC flow rates for micro- and nanoscale  19
loading sample into a static emitter  46

M
measuring flow rates  23
metal contact clip of static emitter  46
method parameters

for a TSQ Series MS detector  106
for an LCQ Series MS detector  81
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microfluidics
components  11
defined  9

micropipettes, using  23
microscale LC/MS and LC connections  24
MRFA  146
MSn  4, 15

N
nanospray

advantages  2
static emitters  15

New Objective replaceable parts  123
nose cone tip (figure)  45
NSI body  28
NSI source

connecting to the extension assembly  61
uninstalling  114

NSI source dialog box, LTQ Series MS detector  90

O
operating a dynamic NSI source

on a TSQ Series MS detector  106
on an LCQ Series MS detector  81
on an LTQ Series MS detector  93

operating conditions for capillary columns  22
operating environment, particulate matter  10
ordering chemicals  148
Osprey MultiMedia Capture software  143

P
packed-tip NSI probe

clogged PEEKsil  115
components  54
liquid junction  72

PEEKsil tubing for the dynamic nanospray probe  49
PEEKsil, clogged  115
PicoFrit columns

as shipped  18
cutting  18
schematic  17

PicoTips  81, 94, 107
positioning the dynamic emitter tip  64
power requirements for nanospray  27
power supply for imaging system LED  41
preparing microfluidic worksite  10
pulled glass capillary  15

R
regulatory compliance  iii
replaceable parts  121

New Objective  123
Upchurch  123

residual calibration compound  114

S
safety standards  iii
setting up

LCQ Series MS detector for NSI/MS operation  76
TSQ Series MS detector for NSI/MS operation  102

Sigma Chemical Company, buying chemicals (note)  148
signal response for NSI/MS  1
solutions, preparing for tuning

a TSQ Series MS detector  147
an LCQ or LTQ Series MS detector  146

solvents
filtering  11
guidelines for  11
impurities  11

split ratios  23
splitting flow  20
spray voltage, determining range

for dynamic nanospray
on a TSQ Series MS detector  111
on an LCQ Series MS detector  85
on an LTQ Series MS detector  97

for static nanospray
on a TSQ Series MS detector  104
on an LCQ Series MS detector  79
on an LTQ Series MS detector  91

static emitter
adjusting compression  45
inserting into nose cone tip  46
loading  46

static nanospray
conditions  15
determining spray voltage

on a TSQ Series MS detector  104
on an LCQ Series MS detector  79
on an LTQ MS detector  91

flow rates below 100 nL/min  67, 119
initiating flow

on a TSQ Series MS detector  103
on an LCQ Series MS detector  77
on an LTQ Series MS detector  90

optimizing ion detection voltages
on a TSQ Series MS detector  105
on an LCQ Series MS detector  80
on an LTQ Series MS detector  92
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static nanospray (continued)
optimizing the emitter position

on a TSQ Series MS detector  105
on an LCQ Series MS detector  79
on an LTQ MS detector  92

PicoTip emitter  43
using the syringe pump to provide backpressure  117

static NSI probe
assembling  44
components (figure)  43
cutting the emitter  44
gas inlet  68
gas inlet (figure)  69
loading sample  46

stereoscope  10
suppliers  125
syringe adaptor, creating  68
syringe assembly (figure)  68
syringe pump

settings
for a TSQ Series MS detector  110
for an LCQ Series MS detector  84
for an LTQ Series MS detector  96

setup for tuning
an LCQ Series NSI/MS system  82
an LTQ Series NSI/MS system  95
on a TSQ Series MS detector  108

T
tables

correlation between tubing IDs and volume  12
effective flow rate range for PicoTip emitters  16
effective flow rate range for SilicaTip emitters  16
operating guidelines for capillary columns  22
optimal flow rate ranges for HPLC columns  19
surface tension of common solvents used in LC/MS  25
tuning and calibration kit summary  147

testing video application  143
Thermo Foundation Instrument Configuration dialog box  
88

troubleshooting
dynamic nanospray  118
microscale LC/MS  119
static nanospray  117
surface tension of solvents  119

tubing
cutting  13
excess length  12
inner diameter and volume  12

tuning
ion transport  67
solution for a TSQ Series MS detector  147
solution for an LCQ or LTQ Series MS detector  146

U
uninstalling the NSI source  114
Upchurch replaceable parts  123

V
video capture card  127
video capture system, installing  127
voltages. See spray voltages or ion detection voltages.

W
weak MS signal  117–118
WEEE compliance  v
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